Introduction

ProSafe-RS has a feature for integration with a CENTUM system, which allows access to ProSafe-RS SCS from the HIS and FCS of the CENTUM VP or CS 3000 (hereafter, referred to as “CENTUM”) system through control bus.

This manual describes how to integrate ProSafe-RS and a CENTUM system. It is important to fully understand the contents in this manual for the engineering or maintenance works. There may be some differences in the behavior on the CENTUM side, depending on the software release number of the CENTUM to which ProSafe-RS is connected. See Appendix for the differences in behavior between different CENTUM software release numbers.

For details of engineering CENTUM VP, see user’s manuals for CENTUM VP. For details of engineering CENTUM CS 3000, see user’s manuals for CENTUM CS 3000.

This manual consists of the following chapters:

Chapter 1
This chapter explains the overview of integration of CENTUM and ProSafe-RS.

Chapter 2
This chapter explains the engineering works regarding the integration of CENTUM and ProSafe-RS.

Chapter 3
This chapter explains how to operate and monitor the ProSafe-RS using HIS.

Appendix
This appendix identifies differences of actions among CENTUM software release numbers.
Safety Precautions for Use

### Safety, Protection, and Modification of the Product

- To protect the system controlled by the Product and the Product itself and to ensure safe operation, please observe the safety precautions described in this Manual. Yokogawa Electric Corporation (“YOKOGAWA”) assumes no liability for safety if users fail to observe the safety precautions and instructions when operating the Product.

- If the Product is used in a manner not specified in the User's Manuals, the protection provided by the Product may be impaired.

- If any protection or safety circuit is required for the system controlled by the Product or for the Product itself, please install it externally.

- Use only spare parts that are approved by YOKOGAWA when replacing parts or consumables of the Product.

- Do not use the Product and its accessories such as power cords on devices that are not approved by YOKOGAWA. Do not use the Product and its accessories for any purpose other than those intended by YOKOGAWA.

- Modification of the Product is strictly prohibited.

- The following symbols are used in the Product and User's Manuals to indicate the accompanying safety precautions:
  
  🔄 Indicates that caution is required for operation. This symbol is labeled on the Product to refer the user to the User's Manuals for necessary actions or behaviors in order to protect the operator and the equipment against dangers such as electric shock. In the User's Manuals, you will find the precautions necessary to prevent physical injury or death, which may be caused by accidents, such as electric shock resulting from operational mistakes.

  ⚡ Identifies a protective conductor terminal. Before using the Product, you must ground the protective conductor terminal to avoid electric shock.

  ″ Identifies a functional grounding terminal. A terminal marked "FG" also has the same function. This terminal is used for grounding other than protective grounding. Before using the Product, you must ground this terminal.

  ~ Indicates an AC supply.

  │ Indicates a DC supply.

  Indicates the ON position of a power on/off switch.

  Indicates the OFF position of a power on/off switch.

### Notes on Handling User's Manuals

- Hand over the User's Manuals to your end users so that they can keep the User's Manuals on hand for convenient reference.

- Thoroughly read and understand the information in the User's Manuals before using the Product.

- For the avoidance of doubt, the purpose of the User's Manuals is not to warrant that the Product is suitable for any particular purpose but to describe the functional details of the Product.

- Contents of the User's Manuals are subject to change without notice.
Every effort has been made to ensure the accuracy of contents in the User's Manuals. However, should you have any questions or find any errors, contact us or your local distributor. The User's Manuals with unordered or missing pages will be replaced.

**Warning and Disclaimer**

- Except as specified in the warranty terms, YOKOGAWA shall not provide any warranty for the Product.
- YOKOGAWA shall not be liable for any indirect or consequential loss incurred by either using or not being able to use the Product.

**Notes on Software**

- YOKOGAWA makes no warranties, either expressed or implied, with respect to the Software Product’s merchantability or suitability for any particular purpose, except as specified in the warranty terms.
- Purchase the appropriate number of licenses of the Software Product according to the number of computers to be used.
- No copy of the Software Product may be made for any purpose other than backup; otherwise, it is deemed as an infringement of YOKOGAWA’s Intellectual Property rights.
- Keep the software medium of the Software Product in a safe place.
- No reverse engineering, reverse compiling, reverse assembling, or converting the Software Product to human-readable format may be performed for the Software Product.
- No part of the Software Product may be transferred, converted, or sublet for use by any third-party, without prior written consent from YOKOGAWA.
Documentation Conventions

## Symbols

The following symbols are used in the User's Manuals.

- **CAUTION**
  Identifies instructions that must be observed to avoid physical injury, electric shock, or death.

- **WARNING**
  Identifies instructions that must be observed to prevent damage to the software or hardware, or system failures of the Product.

- **IMPORTANT**
  Identifies important information required to understand operations or functions.

- **TIP**
  Identifies additional information.

- **SEE ALSO**
  Identifies referenced content.

In online manuals, you can view the referenced content by clicking the links that are in green text. However, this action does not apply to the links that are in black text.

## Typographical Conventions

The following typographical conventions are used throughout the User's Manuals.

### Commonly Used Conventions throughout the User's Manuals

- **Δ Mark**
  Indicates that a space must be entered between character strings.

  **Example:**
  ALΔPIC010Δ-SC

- **Character string enclosed by braces {}**
  Indicates character strings that may be omitted.

  **Example:**
  .PRΔTAG{Δ.sheet name}

### Conventions Used to Show Key or Button Operations

- **Characters enclosed by brackets []**
  When characters are enclosed by brackets in the description of a key or button operation, it indicates a key on the keyboard, a button name in a window, or an item in a list box displayed in a window.

  **Example:**
  To alter the function, press the [ESC] key.

### Conventions of a User-defined Folder

- **User-defined folder name enclosed by parenthesis ( )**
  User definable path is written in a pair of parentheses.

  **Example:**
  (RS Project Folder)\SCS0101
If the RS Project Folder is C:\MYRSPJT, the above path becomes C:\MYRSPJT\SCS0101.

## Drawing Conventions

Drawings used in the User’s Manuals may be partially emphasized, simplified, or omitted for the convenience of description.

Drawings of windows may be slightly different from the actual screenshots with different settings or fonts. The difference does not hamper the understanding of basic functionalities and operation and monitoring tasks.

## Integration with CENTUM

The Product can be integrated with CENTUM VP or CENTUM CS 3000. In the User’s Manuals, the integration with CENTUM VP or CENTUM CS 3000 is referred to as "Integration with CENTUM."

In the User’s Manuals, the explanations for integrating the Product with CENTUM VP or CENTUM CS 3000, the glossary for various features of CENTUM VP is used instead of the glossary for CENTUM CS 3000. For example, the term "CENTUM VP System Alarm View" is used instead of "CENTUM CS 3000 System Alarm window." Nevertheless, if the features for integrating the Product with CENTUM VP and CENTUM CS 3000 are different, both features will be explained separately.

### Explanation of Hardware and Software Behaviors in the User's Manuals

In the User’s Manuals, system behaviors are explained assuming that the latest versions of YOKOGAWA software and hardware at the time of publication of the User’s Manuals are installed.

If additional precise information about the safety of legacy versions of software or hardware is required, a link to the corresponding explanation is provided. Please refer to the information according to your system.

## Station Types

A safety control station (hereafter referred to as SCS) is named according to the type of the safety control unit used in it.

<table>
<thead>
<tr>
<th>Table Info-1 Names of SCS and Safety Control Unit Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of SCS</td>
</tr>
<tr>
<td>SCSV1-S</td>
</tr>
<tr>
<td>SCSP1-S</td>
</tr>
<tr>
<td>SCSP2-S</td>
</tr>
<tr>
<td>SCsu1-S</td>
</tr>
</tbody>
</table>

In the User’s Manuals, the following abbreviations may be used to describe functions of these SCS as a whole.
• SCSV1: Abbreviation of SCSV1-S
• SCSP1: Abbreviation of SCSP1-S
• SCSP2: Abbreviation of SCSP2-S
• SCSU1: Abbreviation of SCSU1-S
Copyright and Trademark Notices

■ All Rights Reserved

The copyright of the programs and online manuals contained in the software medium of the Software Product shall remain with YOKOGAWA.

You are allowed to print the required pages of the online manuals for the purposes of using or operating the Product; however, reprinting or reproducing the entire document is strictly prohibited by the Copyright Law.

Except as stated above, no part of the online manuals may be reproduced, transferred, sold, or distributed to a third party in any manner (either in electronic or written form including, without limitation, in the forms of paper documents, electronic media, and transmission via the network). Nor it may be registered or recorded in the media such as films without permission.

■ Trademark Acknowledgments

• CENTUM, ProSafe, Vnet/IP, and STARDOM are registered trademarks of YOKOGAWA.

• Microsoft, Windows, Windows Vista, Windows Server, Visual Basic, Visual C++, and Visual Studio are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries.

• Adobe, Acrobat, and Adobe Reader are registered trademarks of Adobe Systems Incorporated.

• Ethernet is a registered trademark of Xerox Corporation.

• HART is a registered trademark of the HART Communication Foundation.

• Modicon and Modbus are registered trademarks of Schneider Electric SA.

• All other company and product names mentioned in the User’s Manuals are trademarks or registered trademarks of their respective companies.

• TM or ® mark are not used to indicate trademarks or registered trademarks in the User's Manuals.

• Logos and logo marks are not used in the User’s Manuals.
CONTENTS

1. Overview of CENTUM integration ....................................................... 1-1
2. Engineering for CENTUM integration ............................................... 2-1
   2.1 Engineering on the SENG side.......................................................... 2-2
      2.1.1 Setting of SCS project property ........................................... 2-3
      2.1.2 Defining alarm priorities...................................................... 2-4
      2.1.3 Defining the alarm processing table ...................................... 2-8
      2.1.4 Defining tag names.............................................................. 2-9
      2.1.5 Engineering for overriding from HIS ................................... 2-23
      2.1.6 Settings for exchanging data between FCS and SCS .............. 2-26
      2.1.7 Accessing subsystem's data from CENTUM .......................... 2-28
      2.1.8 Plant hierarchy...................................................................... 2-30
      2.1.9 Saving and downloading operation marks ............................. 2-32
      2.2 Engineering on the CENTUM side .................................................. 2-33
         2.2.1 SCS creation....................................................................... 2-34
         2.2.2 SCS taglist generation......................................................... 2-37
         2.2.3 Other builders ................................................................... 2-39
         2.2.4 Items to note on CENTUM engineering............................... 2-42
      2.3 Tests in the CENTUM integration structure ................................... 2-43
3. Overview of safety system operation and monitoring using HIS...... 3-1
   3.1 Windows used for operation and monitoring of SCS...................... 3-3
      3.1.1 System Alarm view ............................................................... 3-4
      3.1.2 Process Alarm view .............................................................. 3-7
      3.1.3 Instrument faceplates.......................................................... 3-10
      3.1.4 SCS Station Status Display view ......................................... 3-14
      3.1.5 Adjust Time dialog box........................................................ 3-21
      3.1.6 Message monitor of CAMS for HIS...................................... 3-22
   3.2 Other functions used for operation and monitoring of SCS ............ 3-25
Integration with CENTUM VP/CS 3000

IM 32Q01E10-31E 4th Edition

CONTENTS

Appendix

Appendix 1. Differences in limitations and specifications among software release numbers of CENTUM

App.1-1
1. Overview of CENTUM integration

The CENTUM Integration Function of ProSafe-RS provides a communication interface for accessing SCS of ProSafe-RS from HIS and FCS of CENTUM VP or CS 3000 system (hereinafter referred to as "CENTUM") through control bus. By this function, you can operate and monitor SCS from HIS using the same interfaces (windows) for operating and monitoring FCS. You can also access SCS data from FCS using the same interface (tag names) used by an FCS to access other FCS.

CENTUM VP/CS 3000-integrated system configuration

The configuration of a system consisting of ProSafe-RS and CENTUM VP or ProSafe-RS and CS 3000 is called the "CENTUM integration structure". The role of each station in the CENTUM integration structure is as follows:

- To shut down the plant safely if a fault occurs in the plant.
- To perform process control.
- To provide user interfaces for accessing FCS and SCS data.

The following figure shows an example of the CENTUM integration structure. In the CENTUM integration structure, both SCS and FCS can be operated and monitored from HIS. It is also possible to access SCS data from FCS.

![Figure 1-1 CENTUM integration function](image)

Overview of engineering for CENTUM integration

The SENG is a PC which has a license for the engineering functions to build SCS applications. SCS applications written in languages that conform to IEC 61131-3 and used for ProSafe-RS such as Function Block Diagram (FBD) are called application logics. Each application logic is managed as part of the SCS project.
The ENG is a PC which has a license for the CENTUM system generation function. Each CENTUM application generated on the ENG is managed as part of a CENTUM project (CENTUM VP or CS 3000 projects).

Applications to be downloaded to SCS are created on the SENG. One of such applications relates to tag names. A part of the tag-name-related application used for CENTUM integration is also written in the CENTUM project. The tag-name-related definition data written in the CENTUM project is used in the engineering tasks, so that you can operate and monitor SCS from HIS and can access SCS data from FCS.

**Figure 1-2 SCS project and CENTUM project**

### Overview of operation and monitoring from HIS

In the CENTUM integration, the following SCS operations can be performed from an HIS:

- To use tag names to operate and monitor SCS data via the same interface used to monitor FCS data.
- To monitor the status of process alarms and annunciators generated on SCSs in HIS's Process Alarm view.
- To monitor the system alarms generated on SCS in HIS's System Alarm view.
- To display the status of each SCS in HIS's SCS Status Display view.
- To override the application logic variables.
- To set output of the application logics.

**SEE ALSO**

For more information about overriding, refer to:

7.2.1, “Utilizing Forcing and Override Function During Maintenance” in Engineering Guide (IM 32Q01C10-31E)
2. Engineering for CENTUM integration

To realize the CENTUM integration, you need to connect a CENTUM project and an SCS project. To connect these projects, you need to engineer both the SCS project and the CENTUM project. This section describes the engineering tasks required for the CENTUM integration.

### SEE ALSO

For more information about the flow of engineering for CENTUM integration, refer to:


For more information about the relationship between CENTUM projects and SCS projects, refer to:

- "Relationship between Projects" in 2.16, “CENTUM Integration” in Engineering Guide (IM 32Q01C10-31E)
2.1 Engineering on the SENG side

This section describes the engineering tasks performed on the SENG side, which is one of the tasks required to connect an SCS project and a CENTUM project.
2.1.1 Setting of SCS project property

An SCS project and a CENTUM project can be connected using SCS Project Properties in an SCS manager. In SCS Project Properties, specify the folder of the CENTUM project you want to connect to the SCS project. The information for CENTUM integration that has been set in the SCS project can be copied to the CENTUM project folder.

The connection of an SCS project and a CENTUM project is set only in one direction: from the SCS project to the CENTUM project.

See Also
For more information about the relationship of an SCS project and a CENTUM project, refer to:

- Type of Project” in 1.3, “Type of Project” in Engineering Guide (IM 32Q01C10-31E)

For more information about specifying project folders, refer to:

3.1.2. “SCS Project Properties Dialog Box” in Engineering Reference (IM 32Q04B10-31E)
2.1.2  Defining alarm priorities

Process alarms occurred on SCS can be monitored in the Process Alarm view of CENTUM HIS. Alarm priorities for monitoring on the CENTUM HIS can also be defined for the process alarms that occur on SCS.

This section describes the definition of Alarm Priorities in Alarm Priority Builder of ProSafe-RS.

■ ProSafe-RS Alarm Priority Builder

By using the Alarm Priority Builder, you can define the alarm output format and alarm action when an alarm has occurred or returned to a normal state for each SCS. Alarm priorities are classified as high-priority alarm, medium-priority alarm, low-priority alarm, logging alarm, and reference alarm.

To start the Alarm Priority Builder, do the following: From the SCS Manager, click [Tools] > [Engineering] to start the Engineering Launcher, and select [Alarm Priority Builder] from the menu.

For each alarm priority, set the alarm flashing action, re-warning, and flashing action upon returning to NR. Ensure that the [NR (Flashing)] setting on the Alarm Priority Builder on SENG is the same as the [NR] setting that is configured on the Alarm Priority Builder of the CENTUM System Builders.

TIP

The ProSafe-RS Alarm Priority Builder is different from the CENTUM Alarm Priority Builder. You cannot set the behavior of HIS from the ‘Alarm Priority Builder on SENG.’

■ Downloading to an SCS

When alarm priorities are defined, the information is reflected in the SCS download database. Perform offline download of the database to the SCS using SCS Manager on SENG.

SEE ALSO

For more information about offline download, refer to:

■ Differences from CENTUM Alarm Priority Builder

When connecting an SCS project to a CENTUM project, two alarm priority builders must be used properly: one is ProSafe-RS Alarm Priority Builder launched from SCS Manager on the SENG, the other is Alarm Priority Builder launched from CENTUM System View. These two builders are used for their respective projects, with the following differences between the two:

- Target station
  ProSafe-RS Alarm Priority Builder can be used to change definitions for each SCS.
  CENTUM Alarm Priority Builder is common throughout the CENTUM project, and the definitions set in this builder apply to all HIS and FCS.

- Setting items
  ProSafe-RS Alarm Priority Builder is used to set SCS data, while CENTUM Alarm Priority Builder is used to set HIS and FCS data. Accordingly, the setting items are different between the two alarm priority builders.

| Table 2.1.2-1 Setting items in ProSafe-RS and CENTUM Alarm Priority Builders |
|-------------------------|-------------------------|-------------------------|-------------------------|
| Title                  | Item                    | ProSafe-RS Alarm Priority Builder | CENTUM Alarm Priority Builder |
| CRT                    | Window display          | Setting item not available | Can be set |

Continues on the next page
### Table 2.1.2-1 Setting items in ProSafe-RS and CENTUM Alarm Priority Builders (Table continued)

<table>
<thead>
<tr>
<th>Title</th>
<th>Item</th>
<th>ProSafe-RS Alarm Priority Builder</th>
<th>CENTUM Alarm Priority Builder</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRT Printing</td>
<td>Setting item not available</td>
<td>Can be set</td>
<td></td>
</tr>
<tr>
<td>Historical File</td>
<td>Storing in files</td>
<td>Setting item not available</td>
<td>Can be set</td>
</tr>
<tr>
<td>Buzzer Sound</td>
<td>Buzzer sound generation</td>
<td>Setting item not available</td>
<td>Can be set</td>
</tr>
<tr>
<td>Alarm Action</td>
<td>Alarm flashing action</td>
<td>Can be set</td>
<td>Can be set (*1)</td>
</tr>
<tr>
<td>Rewarning</td>
<td>Rewarning</td>
<td>Can be set</td>
<td>Can be set (*1)</td>
</tr>
<tr>
<td>NR (Flashing)</td>
<td>Flashing action upon returning to the NR state</td>
<td>Can be set (*2)</td>
<td>Can be set (*1)</td>
</tr>
</tbody>
</table>

*1: Defined only for FCSs
*2: Must be the same as settings on CENTUM Alarm Priority Builder

**File compatibility**

The builder files created in ProSafe-RS Alarm Priority Builder as well as their copies saved in different names cannot be opened in or imported to CENTUM Alarm Priority Builder, or vice versa. CSV files must be used to exchange data between the two builders.

**Other**

ProSafe-RS Alarm Priority Builder has no download menu. Downloading from this builder is performed in SCS Manager.

### Window of ProSafe-RS Alarm Priority Builder

The following figure shows the Alarm Priority Builder main window:

![Main window of the Alarm Priority Builder](image_url)

- **Title bar**
- **Menu bar**
- **Tool bar**
- **Data menu area**
- **Message display area**
- **Workspace**
- **Status bar**

**Figure 2.1.2-1 Main window of the Alarm Priority Builder**
Setting items

ProSafe-RS Alarm Priority Builder has tabs corresponding to different alarm priority levels. All or some of the following items can be set in each of these tabs:

Table 2.1.2-2 Setting items

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Action</td>
<td>Specify the alarm flashing action.</td>
</tr>
<tr>
<td>Rewarning</td>
<td>Specify whether to enable or disable rewarning.</td>
</tr>
<tr>
<td>NR (Flashing)</td>
<td>Specify the alarm action upon returning to the NR state.</td>
</tr>
</tbody>
</table>

In ProSafe-RS Alarm Priority Builder, set each action upon occurrence and recovery of alarms, for each alarm priority.

The actions corresponding to the blank fields in the following table cannot be set:

Table 2.1.2-3 Alarm priorities and settable items

<table>
<thead>
<tr>
<th>Item</th>
<th>High-priority alarm(*1)</th>
<th>Medium-priority alarm (*1)</th>
<th>Low-priority alarm (*1)</th>
<th>Logging alarm(*1)</th>
<th>Reference alarm (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Occurrence</td>
<td>Recovery</td>
<td>Occurrence</td>
<td>Recovery</td>
<td>Occurrence</td>
</tr>
<tr>
<td>Alarm Action</td>
<td>Yes</td>
<td>Lock</td>
<td>Yes</td>
<td>Lock</td>
<td>Yes</td>
</tr>
<tr>
<td>Rewarning</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NR (Flashing)</td>
<td>Yes</td>
<td>On Alarm</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: Yes: Can be set
Other than Yes: Fixed value (cannot be specified)

 Alarm Action

In Alarm Action (alarm flashing action), set the flashing indication used to notify the operator when an alarm has occurred. The desired flashing indication can be selected from the following three types:

Table 2.1.2-4 Types of flashing indication

<table>
<thead>
<tr>
<th>Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock</td>
<td>The flashing indication will continue until the operator performs an acknowledge-ment operation, even after the alarm is reset upon returning to the NR state.</td>
</tr>
<tr>
<td>Non-lock Type</td>
<td>The flashing indication will stop without the operator performing an acknowledge-ment operation, when the alarm is reset upon returning to the NR state.</td>
</tr>
<tr>
<td>Self ACK</td>
<td>Flashing indication is not implemented, since the system will automatically acknowledge the alarm as soon as it is generated.</td>
</tr>
</tbody>
</table>

 Rewarning

Rewarning is the alarm that notifies the operator of a continuing alarm state. This item can be specified only for high-priority alarms. The alarm message will be output again at the rewarning periods or when specified by command.

Table 2.1.2-5 Types of rewarning

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0: No</td>
<td>Rewarning is not issued</td>
</tr>
<tr>
<td>1: Yes</td>
<td>Rewarning is issued</td>
</tr>
</tbody>
</table>
The rewarning period is set in SCS Constants Builder.

For more information about SCS Constants Builder, refer to:
3.1.3, “SCS Constants Builder” in Engineering Reference (IM 32Q04B10-31E)

NR (Flashing)

NR (Flashing) defines the flashing indication used to notify the operator that all alarms in a given function block have been recovered upon returning to the NR state. The following two types of flashing display definitions are available for notifying the operator: This item can be specified only for high-priority alarms.

Table 2.1.2-6 Types of alarm action upon returning to NR

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Alarm Dependent</td>
<td>When all alarms have been reset upon returning to the NR state, the current flashing status will continue. If the indicator is flashing when the NR state is restored, the flashing will continue. If the indicator is not flashing when the NR state is restored, the non-flashing status will continue.</td>
</tr>
<tr>
<td>Notification at Return (*1)</td>
<td>When all alarms have been reset upon returning to the NR state, the flashing to indicate the NR state will start. Even when this flashing is not acknowledged, the flashing will stop when a new alarm is generated. Return of the entire function block to the NR state is notified by a Non-Lock action.</td>
</tr>
</tbody>
</table>

*1: Must be the same as the settings on CENTUM Alarm Priority Builder.
If the two settings are different, for example, the [NR] on CENTUM is set to [On Alarm Dependent] and the [NR (Flashing)] on the ProSafe-RS is set to [Notification at Return], the process alarm LED on the SCS blinks according to [Notification at Return], but no return sound is output.

If Alarm Action is set to "Self ACK" and alarm type upon returning to NR is set to "Notification at Return," an error message will be output when a file is saved.
2.1.3 Defining the alarm processing table

You can monitor the process alarms raised by the SCS from the Process Alarm view on the CENTUM HIS. This section describes how to operate Alarm Processing Table Builder.

TIP

The Alarm Processing Table Builder on the ProSafe-RS and the Alarm Processing Table Builder on CS 3000 are two different entities.

Alarm Processing Table Builder

The Alarm Processing Table Builder determines the priority of alarms raised by Mapping block on SCS. The priority levels are 1 to 16.

Set the color and priority levels on the Alarm Processing Table Builder on the CENTUM and import the settings to the Alarm Processing Table Builder on ProSafe-RS because the builder on ProSafe-RS has no editing feature.

Engineering flow

Unlike the other builders, the Alarm Processing Table Builder on the ProSafe-RS imports the contents of settings on the Alarm Processing Table Builder on CENTUM. If the settings for the table used by SCS are changed on the Alarm Processing Table Builder on CENTUM, be sure to import the file for the Alarm Processing Table Builder on CENTUM to the Alarm Processing Table Builder on the ProSafe-RS. To reflect the imported data on the SCS, offline-downloading is required.

The engineering procedure is as follows:

With the SCS Manager, display the [SCS Project Properties] dialog box, select the [Project] tab, and enter the 'top folder of the CENTUM Project' into the field [CENTUM Project Folder]. Do this before going on to the following steps.

1. Start the Alarm Processing Table Builder:
   From the SCS Manager, click [Tools] > [Engineering] to start the Engineering Launcher, and select [Alarm Processing Table Builder] from the menu.

2. From the menu, select [File] > [External file] > [Import...].
   The following Import dialog appears.

3. Select the AlmTbl.edf of a CENTUM project and click the [Open] button.

4. From the menu of the Alarm Processing Table Builder, select [File] > [Save]. The AlmTbl.edf is saved in the SCS Project.

5. To reflect the contents in the AlmTbl.edf file on the SCS, execute [Build] in SCS Manager before offline-downloading.

Figure 2.1.3-1 Import dialog box
2.1.4 Defining tag names

When SCS project and CENTUM project are connected, tag names must be defined so that application logic variables and function blocks can be accessed from HIS or FCS. Tag names are defined in Tag Name Builder.

Overview of tag name definition

In Tag Name Builder, define tag names for application logic variables or function blocks. Function blocks or variables having a defined tag name can be accessed from HISs based on their correspondence to Mapping Block/Element.

The following information is defined using Tag Name Builder: Tag names can only be defined for certain types of variable.

- Tag name
- Parameters required by Mapping Block/Element on SCS
- Parameters required by instrument faceplates on HIS

The procedure for defining tag names is as follows:

1. Define application logic variables or function block instances in Dictionary View of SCS Manager.
2. Define tag names and parameters in Tag Name Builder.
   
   To start the Tag Name Builder, do the following: From the SCS Manager, click [Tools] > [Engineering] to start the Engineering Launcher, and select [Tag Name Builder] from the menu.


SEE ALSO

For more information about the variables for which a tag name can be defined as well as the applicable definition items, refer to:

“Setting items” on page 2-11

For more information about the mapping blocks/elements, refer to:

D2.1, “Overview of tag name interfaces” in Safety Control Station Reference (IM 32Q03B10-31E)

Window of Tag Name Builder

The following figure shows the Tag Name Builder main window:
You can register a variable name in Tag Name Builder by dragging the variable name from Dictionary View and dropping it into a variable name field in Tag Name Builder. When multiple variable names are dragged and dropped, the variable names are registered in multiple variable fields starting from the top field. If a variable name is already registered in the variable name field, the variable name field is overwritten.

Figure 2.1.4-1 Main window of the Tag Name Builder
Setting items

The following table shows the variable types for which tag names can be defined with Tag Name Builder. The setting Advanced Setting Items of Tag Name Builder vary depending on the variable type.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>BOOL variable</td>
</tr>
</tbody>
</table>

Continues on the next page
Table 2.1.4-1 Variable types whose tag name can be defined with the Tag Name Builder (Table continued)

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DINT</td>
<td>Integer variable</td>
</tr>
<tr>
<td>REAL</td>
<td>Real variable</td>
</tr>
<tr>
<td>ANLG_S</td>
<td>Analog Input function block instance</td>
</tr>
<tr>
<td>ANLG_I</td>
<td>ANLG_I function block instance</td>
</tr>
<tr>
<td>VEL</td>
<td>VEL function block instance</td>
</tr>
<tr>
<td>ANN</td>
<td>ANN function block instance</td>
</tr>
<tr>
<td>ANN_FUP</td>
<td>ANN_FUP function block instance</td>
</tr>
<tr>
<td>IO_REAL</td>
<td>Analog real input variable</td>
</tr>
<tr>
<td>IO_BOOL</td>
<td>Discrete BOOL I/O variable</td>
</tr>
<tr>
<td>GOV_B</td>
<td>Grouping override function block instance (BOOL type)</td>
</tr>
<tr>
<td>GOV_IB</td>
<td>Grouping override function block instance (discrete BOOL I/O variable)</td>
</tr>
<tr>
<td>OVR_B</td>
<td>Override function block instance (BOOL type)</td>
</tr>
<tr>
<td>OVR_I</td>
<td>Override function block instance (integer type)</td>
</tr>
<tr>
<td>OVR_R</td>
<td>Override function block instance (real type)</td>
</tr>
<tr>
<td>OVR_IR</td>
<td>Override function block instance (analog real input variable)</td>
</tr>
<tr>
<td>OVR_IB</td>
<td>Override function block instance (discrete BOOL I/O variable)</td>
</tr>
<tr>
<td>PASSWD</td>
<td>Password function block instance</td>
</tr>
<tr>
<td>ECW_B</td>
<td>External communication function block instance (BOOL type)</td>
</tr>
<tr>
<td>ECW_I</td>
<td>External communication function block instance (integer type)</td>
</tr>
<tr>
<td>ECW_R</td>
<td>External communication function block instance (real type)</td>
</tr>
<tr>
<td>SCI_B</td>
<td>Subsystem communication function block instance (BOOL type input variable)</td>
</tr>
<tr>
<td>SCI_I</td>
<td>Subsystem communication function block instance (integer type input variable)</td>
</tr>
<tr>
<td>SCI_R</td>
<td>Subsystem communication function block instance (real type input variable)</td>
</tr>
<tr>
<td>SCO_B</td>
<td>Subsystem communication function block instance (BOOL type output variable)</td>
</tr>
<tr>
<td>SCO_I</td>
<td>Subsystem communication function block instance (integer type output variable)</td>
</tr>
<tr>
<td>SCO_R</td>
<td>Subsystem communication function block instance (real type output variable)</td>
</tr>
<tr>
<td>MOB_11</td>
<td>Manual operation block instance with two-position answerback (BOOL)</td>
</tr>
<tr>
<td>MOB_21</td>
<td>Manual operation block instance with three-position answerback (BOOL)</td>
</tr>
<tr>
<td>MOB_RS</td>
<td>Manual operation block instance with auto-reset (BOOL)</td>
</tr>
<tr>
<td>MOA</td>
<td>Analog manual operation block instance</td>
</tr>
</tbody>
</table>

The following table shows the setting items for Tag Name Builder and whether each setting item can be changed online. In addition to the setting items, reference items are also provided for checking the settings in Dictionary View and I/O Wiring View. The reference items cannot be changed with Tag Name Builder. All items can be printed.

Table 2.1.4-2 Items

<table>
<thead>
<tr>
<th>Item</th>
<th>Online changes (*1)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable Name</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

Continues on the next page
The following table shows the advanced setting items for Tag Name Builder and whether each setting item can be changed online. To display the items, in the [View] menu, place a check mark next to [Detailed Setting Items].

**Table 2.1.4-3 Advanced setting items**

<table>
<thead>
<tr>
<th>Item</th>
<th>Online changes (*1)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag Mark</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Alarm Level</td>
<td>Yes</td>
<td>Specify a value of 1 to 16.</td>
</tr>
<tr>
<td>Upper Window</td>
<td>Yes</td>
<td>Set the upper window created on the CENTUM.</td>
</tr>
<tr>
<td>Help</td>
<td>Yes</td>
<td>Set the help message created using CENTUM Help Builder.</td>
</tr>
<tr>
<td>Scale Reverse</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Scale-division</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Double Authentication</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Alarm in Overriding</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

*1:  Yes: Online changeable  
-: Not applicable

Continues on the next page
Table 2.1.4-3 Advanced setting items (Table continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Online changes (*1)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer back Alarm</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Password ON Alarm</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Output High Limit</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Output Low Limit</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Output Scale High Limit</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Output Scale Low Limit</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Upper Equipment Name</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

*1: Yes: Online changeable

The following table shows the setting items for each variable type:

Table 2.1.4-4 Variable types and setting items (1/2)

<table>
<thead>
<tr>
<th>Setting item</th>
<th>BOOL</th>
<th>DINT</th>
<th>REAL</th>
<th>ANLG_S</th>
<th>VEL</th>
<th>ANN</th>
<th>IO_REAL</th>
<th>IO_BOOL</th>
<th>GOV_B</th>
<th>GOV_IB</th>
<th>OVR_B</th>
<th>OVR_IB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable Name</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Tag Name</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Tag Comment</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Annunciator Message</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Low Limit</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>High Limit</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Unit</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Level</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Label</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Button 1</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Button 2</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Button Top</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Button Bottom</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Switch Position Label</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*1: Yes: Can be set
- Setting item not available
*2: Tag name specification is not required (even if a tag name is not defined, the variable can still be accessed from HISs using an element number).
### Table 2.1.4-5 Variable types and setting items (2/2)

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Variable type (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OVR_I</td>
</tr>
<tr>
<td></td>
<td>OVR_R</td>
</tr>
<tr>
<td></td>
<td>OVR_IR</td>
</tr>
<tr>
<td></td>
<td>PASSWD</td>
</tr>
<tr>
<td></td>
<td>SCI_B</td>
</tr>
<tr>
<td></td>
<td>SCI_I</td>
</tr>
<tr>
<td></td>
<td>SCI_R</td>
</tr>
<tr>
<td></td>
<td>MOB_11</td>
</tr>
<tr>
<td></td>
<td>MOB_RS</td>
</tr>
<tr>
<td></td>
<td>MOA</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Tag Name</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Tag Comment</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Annunciator Message</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Low Limit</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>High Limit</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Unit</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Level</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Label</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Button 1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Button 2</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Button Top</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Button Bottom</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Switch Position Label</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>

*1: Yes: Can be set
-: Setting item not available

### Table 2.1.4-6 Variable types and advanced setting items (1/2)

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Variable type (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BOOL</td>
</tr>
<tr>
<td></td>
<td>ECW_B</td>
</tr>
<tr>
<td></td>
<td>DINT</td>
</tr>
<tr>
<td></td>
<td>REAL</td>
</tr>
<tr>
<td></td>
<td>ANLG_S</td>
</tr>
<tr>
<td></td>
<td>ANLGI</td>
</tr>
<tr>
<td></td>
<td>VEL</td>
</tr>
<tr>
<td></td>
<td>ANN</td>
</tr>
<tr>
<td></td>
<td>ANN_FUP</td>
</tr>
<tr>
<td></td>
<td>IO_REAL</td>
</tr>
<tr>
<td></td>
<td>IO_BOOL</td>
</tr>
<tr>
<td></td>
<td>GOV_B</td>
</tr>
<tr>
<td></td>
<td>GOV_IB</td>
</tr>
<tr>
<td></td>
<td>OVR_B</td>
</tr>
<tr>
<td></td>
<td>OVR_IB</td>
</tr>
<tr>
<td>Tag Mark</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Alarm Level</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Upper Window</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Help</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Scale Reverse</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Scale-division</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Double Authentication</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Alarm in Overriding</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 2.1.4-6 Variable types and advanced setting items (1/2) (Table continued)

<table>
<thead>
<tr>
<th>Setting item</th>
<th>Variable type (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BOOL</td>
</tr>
<tr>
<td>Answer back Alarm</td>
<td>-</td>
</tr>
<tr>
<td>Password ON Alarm</td>
<td>-</td>
</tr>
<tr>
<td>Output High Limit (%)</td>
<td>-</td>
</tr>
<tr>
<td>Output Low Limit (%)</td>
<td>-</td>
</tr>
<tr>
<td>Output Scale High Limit (%)</td>
<td>-</td>
</tr>
<tr>
<td>Output Scale Low Limit (%)</td>
<td>-</td>
</tr>
<tr>
<td>Upper Equipment Name</td>
<td>-</td>
</tr>
</tbody>
</table>

*1: Yes: Can be set  
* Setting item not available

*2: For GOV_B and GOV_IB, no setting is required.

### Table 2.1.4-7 Variable types and advanced setting items (2/2)

<table>
<thead>
<tr>
<th>Setting item</th>
<th>Variable type (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OVR_I</td>
</tr>
<tr>
<td>Tag Mark</td>
<td>Yes</td>
</tr>
<tr>
<td>Alarm Level</td>
<td>Yes</td>
</tr>
<tr>
<td>Upper Window</td>
<td>Yes</td>
</tr>
<tr>
<td>Help</td>
<td>Yes</td>
</tr>
<tr>
<td>Scale Reverse</td>
<td>-</td>
</tr>
<tr>
<td>Scale-division</td>
<td>-</td>
</tr>
<tr>
<td>Double Authorization</td>
<td>Yes</td>
</tr>
<tr>
<td>Alarm in Overriding</td>
<td>Yes</td>
</tr>
<tr>
<td>Answer back Alarm</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Setting item</th>
<th>Variable type (*1)</th>
<th>PASSWD</th>
<th>SCI_B</th>
<th>SCI_I</th>
<th>SCI_R</th>
<th>SCO_B</th>
<th>SCO_I</th>
<th>SCO_R</th>
<th>MOB_11</th>
<th>MOB_RS</th>
<th>MOA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password ON Alarm</td>
<td></td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Output High Limit (%)</td>
<td></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output Low Limit (%)</td>
<td></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output Scale High Limit (%)</td>
<td></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>(-2)</td>
</tr>
<tr>
<td>Output Scale Low Limit (%)</td>
<td></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>(-3)</td>
</tr>
<tr>
<td>Upper Equipment Name</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: Yes: Can be set  
-: Setting item not available  
*2: Fixed to 100.0. For display purpose only.  
*3: Fixed to 0.0. For display purpose only.

### Variable Name

To assign a tag name to a function block instance, enter the [instance name] as the variable name. From among the variables created in SCS Manager, specify the variable name you want to assign a tag name. A tag name can be defined regardless of the scope of the variable.

In case of a local variable, enter a scope name after "@."

In case of an internal variable of a user-defined function block, assign an instance name using Dictionary View of SCS Manager. The variable name is specified in the format of "[Instance Name].[Internal Variable Name]." Up to two nests are permitted in each variable to which a tag name is assigned.

<table>
<thead>
<tr>
<th>Variable name (*1)</th>
<th>Scope</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR1</td>
<td>Global</td>
<td>Global variable</td>
</tr>
<tr>
<td>VAR2@PROG1</td>
<td>PROG1</td>
<td>Local variable of PROG1 function</td>
</tr>
<tr>
<td>FB01.VAR3</td>
<td>Global</td>
<td>Internal variable VAR3 of user-defined function block instance FB01</td>
</tr>
<tr>
<td>FB01.VAR3@PROG1</td>
<td>PROG1</td>
<td>Internal variable VAR3 of user-defined function block instance FB01 defined locally in PROG1 function</td>
</tr>
<tr>
<td>FB01.FB2.VAR3</td>
<td>Global</td>
<td>Internal variable VAR3 of user-defined function block instance FB2, which is used in user-defined function block instance FB01 (maximum limit of function block nesting)</td>
</tr>
</tbody>
</table>

*1: The variable name can contain up to 69 single-byte characters. Tag Name Builder also checks the following items:
- The variable name consists only of alphanumeric characters and "@", ".", or ":". If any other character is used, an error will occur.
- The variable name begins with an alphabetic character or ":"; otherwise, an error will occur.
- Three or more nests in a variable will result in an error. The variables "FB01.VAR3" and "FB01.VAR3@PROG1" have one nest, while "FB01.FB2.VAR3" has two nests.
- **Tag Name**
  A name used to access each application logic variable from HIS. A tag name can contain up to 16 single-byte alphanumeric characters including "_" and "-". Note that tag names cannot begin with "_" or "-". All characters are converted to uppercase as they are entered. Tag names must be unique within the CENTUM project.

- **Tag Comment**
  A comment assigned to a tag name. It can be defined within 24 single-byte characters.

- **Annunciator Message**
  A message notifying the process error. You can define any string within 80 single-byte characters.
  Default: None

- **Unit**
  A symbol indicating the engineering unit of data such as flow rate and pressure. A unit can be defined within 6 single-byte characters.
  Default: %

- **Low Limit**
  A low limit (SL) is the lowest point of engineering data scale. It can be defined using up to seven digits including a sign and decimal point. This setting is referenced by HIS only for display purposes and not used in calculation or alarm processing of the SCS. Enter the same value as the low limit set on Multi-Language Editor, although a different value can be set.
  Default: 0.0

- **High Limit**
  A high limit (SH) is the highest point of engineering data scale. It can be defined using up to seven digits including a sign and decimal point. This setting is referenced by HIS only for display purposes and not used in calculation or alarm processing of the SCS. Enter the same value as the "High limit" set on Multi-Language Editor, although a different value can be set.
  Default: 100.0

- **Label**
  A display format applied to the switch position label displayed on each button on the instrument faceplates of HIS. Two label formats are available: Direct and Reverse. Either type can be specified.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Direct</td>
</tr>
<tr>
<td>2</td>
<td>Reverse</td>
</tr>
</tbody>
</table>

Default: Direct

- **Button 1/Button 2**
  A button color can be specified for each button on the instrument faceplates of HIS.
  Select a button color from one of the following 16 colors:
When each button (switch) is pressed, the button color will change to the specified color.

Default: Red

**Button Top/Button Bottom**

Each button on the instrument faceplates of HIS can be divided into the top and bottom sections and its color can be specified for each section. Sixteen colors are available, corresponding to the colors shown in "Button 1/Button 2" above, except for "N: Black," which is substituted by "N: Background color."

**Level**

Variables can be classified according to their priorities. Eight levels from 1 to 8 are available, and the security level increases as the number increases. The operation and monitoring privileges on the HIS with respect to each data item will change depending on the function constraint level. Enter a number between 1 and 8.

Default: 4

For more information about levels, refer to:

- 3.4, "Function Block Security" in the CENTUM VP Engineering Reference Vol. 1 (IM 33K03G21-50E)
- F3.4, "Function Block Security" in the CENTUM VP Reference Engineering (IM 33M01A30-40E)
- F9.4, "Function Block Security" in the CS 1000/CS 3000 Reference Engineering (IM 33S01B30-01E)

**Switch Position Label**

A label displayed on each button on the HIS instrument faceplates. Switch position labels 1 to 4 can be defined using up to eight single-byte or four double-byte characters. However, the following characters cannot be used:

, (comma), | (vertical bar), ' (single quotation), " (double quotation), \ (back slash), and #

Default: ON,,OFF,ON

**Tag Mark**

A tag mark indicating the tag name priority and process status. The following four tag name priorities are available:

- Important
- General
- Aux.1
- Aux.2

For each tag name, alarm confirmation mode can be set as either "with acknowledgement (with Ack)" or "without acknowledgement." You can select from the following eight types of combinations of priority levels and confirmation modes. Enter a number from 1 to 8.

<table>
<thead>
<tr>
<th>Table 2.1-4-10 Tag marks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

Continues on the next page
Table 2.1.4-10 Tag marks (Table continued)

<table>
<thead>
<tr>
<th>Number</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>General</td>
</tr>
<tr>
<td>3</td>
<td>Aux.1</td>
</tr>
<tr>
<td>4</td>
<td>Aux.2</td>
</tr>
<tr>
<td>5</td>
<td>Important</td>
</tr>
<tr>
<td>6</td>
<td>General with Ack.</td>
</tr>
<tr>
<td>7</td>
<td>Aux.1 with Ack.</td>
</tr>
<tr>
<td>8</td>
<td>Aux.2 with Ack.</td>
</tr>
</tbody>
</table>

Default: 2 (General)

In some function blocks, a reconfirmation dialog box always appears if you try to change an MV.

SEE ALSO

For more information about the reconfirmation dialog box, refer to:

* Reconfirmation dialog box” on page 3-12

### Alarm Level

Define a processing level on an HIS for each alarm generated with respect to a given tag name. You can specify an alarm priority and display color for all alarms generated in relation to the tag name. You can select an alarm processing level from the 16 levels listed in the following table: The alarm levels 1 to 4 are fixed. Enter the number using single-byte characters.

Table 2.1.4-11 Alarm processing levels

<table>
<thead>
<tr>
<th>Level</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High</td>
<td>High-priority alarm</td>
</tr>
<tr>
<td>2</td>
<td>Medium</td>
<td>Medium-priority alarm</td>
</tr>
<tr>
<td>3</td>
<td>Low</td>
<td>Low-priority alarm</td>
</tr>
<tr>
<td>4</td>
<td>Logging</td>
<td>Logging alarm</td>
</tr>
<tr>
<td>5</td>
<td>User (5)</td>
<td>These types are defined in the CENTUM Alarm Processing Table Builder. Equalize to the setting from the Alarm Processing Table Builders on CENTUM.</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>User (16)</td>
<td></td>
</tr>
</tbody>
</table>

Default: 1 (High)

### Upper Window

An upper window is a window that is called when the graphic button in a toolbox or graphic key on the operation keyboard is operated on HIS while a tag name is selected. The upper window can be specified for each tag name. 

Default: None

### Help

You can specify a number for each help message displayed on HIS. The user can define desired help messages using CENTUM Help Builder and specify a number between HW0001 and HW9999 for each of these messages. Specify the applicable number to display the help dialog box showing the corresponding help message.

Default: HW000 (no help message)
● Scale Reverse

This display method causes the top of the scale shown on the instrument faceplates of HIS to become the low limit, and its bottom the high limit. Specifying "Yes" will activate reverse display. Either "Yes" or "No" can be selected.

Default: No

● Scale-division

You can select 1, 2, 3, 4, 5 or 7 divisions for the scale on the instrument faceplates of HIS. You can also set "AUTO" to let the system determine the division number automatically.

Default: AUTO

● Double Authentication

Use this function if you want to grant operation permission based on approvals of two users—the logged-in user and another user—when operating important tag names from an HIS. When the use of double authentication is defined, the reconfirmation dialog box with double authentication appears. Specifying "Yes" will enable double authentication. Either "Yes" or "No" can be selected.

Default: No

● Alarm in Overriding

Specify whether or not to generate a process alarm to notify that a grouping override function block or an override function block is overriding. Specifying "Yes" will cause an applicable process alarm to be generated. Either "Yes" or "No" can be selected.

Default: Yes

SEE ALSO
For more information about the overriding alarm, refer to:

"■ Process alarm" in D3.2, “Tag name interfaces and process alarms of override function blocks” in Safety Control Station Reference (IM 32Q03B10-31E)

● Answer-back Alarm

Specify whether the process alarm is to be generated when the Override Operation or Manual Operation from HIS does not work properly. For example, a process alarm can be generated when the Manual Operation Function Block detects discrepancy between the output signal to a valve and the answerback input value from the limit switch of the valve. You can select "Both" (answerback error on both the ON and OFF sides), "ON", "OFF" or "No".

Default: Both

Table 2.1.4-12 Option for answer-back alarm

<table>
<thead>
<tr>
<th>Variable type</th>
<th>OVR_B, OVR_I, OVR_R, OVR_IR, OVR_IB, MOB_RS(*)</th>
<th>MOB_11, MOB_12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>0: No</td>
<td>0: No</td>
</tr>
<tr>
<td></td>
<td>1: Both (Default)</td>
<td>1: Both (Default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3: OFF</td>
</tr>
</tbody>
</table>

*1: For GOV_B, GOV_IB, and PASSWD, no setting is required.

SEE ALSO
For more information about the answerback error alarm, refer to:

"■ Process alarm" in D3.2, “Tag name interfaces and process alarms of override function blocks” in Safety Control Station Reference (IM 32Q03B10-31E)
Password ON Alarm
Specify whether or not to generate a process alarm when the PASSWD function block is outputting 1 as the result of overriding by HIS. Specifying "Yes" will cause an applicable process alarm to be generated. Either "Yes" or "No" can be selected.
Default: Yes

For more information about the password ON alarm, refer to:

Settings in the Tag Name Builder” in D3.7, “Tag name interfaces and process alarms of password function blocks” in Safety Control Station Reference (IM 32Q03B10-31E)

Output High Limit
Specify the upper output limit within the range 0.0% to 100.0%.
Default: 100.0%

Output Low Limit
Specify the lower output limit within the range 0.0% to 100.0%
Default: 0 %

Output Scale High Limit
Fixed to 100.0 %.

Output Scale Low Limit
Fixed to 0.0%.

Upper Equipment Name
Specify the upper equipment name set on the CENTUM.
Default: None

Figure 2.1.4-3 Setting of upper equipment names
2.1.5 Engineering for overriding from HIS

When overriding from an HIS, use one of the following two types of function blocks:

• Grouping Override Function Blocks
• Override Function Blocks

These types of function blocks include function blocks that should be selected according to the data type of the variable to override. To manage multiple override function blocks as a group, use the grouping override function block.

SEE ALSO
For more information about the details of override function blocks, refer to:
7.2.1, “Utilizing Forcing and Override Function During Maintenance” in Engineering Guide (IM 32Q01C10-31E)

Engine for overriding from HIS

The engineering procedure for performing an override is as follows:

1. Define a grouping override function block instance using Dictionary View of SCS Manager.
2. Use the Multi-Language Editor to place the instance into the application logic.
3. Connect the input value for normal operation to the IN terminal. This value is output when override is not performed. Specify the value to be output during override for the VAL terminal.
4. Set the Group number of this instance in a fixed value for the GRP terminal.
5. Connect the input that permits or prohibits override to the SW terminal.
6. Use the Tag Name Builder to define a tag name for the grouping override function block instance.

You can use the tag name to perform grouping override from an HIS.

2.1 Engineering on the SENG side >
4. Connect the input that permits or prohibits override to the SW terminal.

```
OVR_IB
Internal variable

Input variable

TRUE

VAL

OVRSW

OUT

<IO_BOOL data>

TRUE VAL

SW

OVRSW

BOOL variable
```

Figure 2.1.5-2 Example of override function block

5. Use the Tag Name Builder to define a tag name for the override function block instance. You can use the tag name to perform override from an HIS.

### Engineering for overriding using a password function block

Combining a password function block with an override function block will allow you to enable or disable override operations from an HIS using a password. The engineering procedure for connecting a password function block to a created override function block is as follows:

1. Define a password function block instance using Dictionary View of SCS Manager.
2. Use the Multi-Language Editor to place the defined password function block instance into the application logic.
3. Define a password string you need to enter for operation from an HIS for the password function block.
4. Search for the override function block instance to which this password function block is connected.
5. Connect the output parameter OUT of the password function block to the input parameter SW of the override function block.

```
<Password>

PSWD

OUT

BOOL variable

OVRSW

OVR_IB
Internal variable

Input variable

TRUE

VAL

OVRSW

OUT

<IO_BOOL data>
```

Figure 2.1.5-3 Example where a password function block is used to permit override

6. If necessary, use the Resource Editor of SCS Manager to set a password for the POU that contains the created password function block. This will restrict the reference to and printing of the password function block by opening the POU and prevent an unauthorized user from referencing a password.
7. Use the Tag Name Builder to specify a tag name for the password function block instance.

For more information about engineering for password function block, refer to:

C10.10, “SYS_PSWD (password function blocks management)” in Safety Control Station Reference (IM 32Q03B10-31E)
2.1.6 Settings for exchanging data between FCS and SCS

For setting data from FCS to SCS, use SCS link transmission or external communication function block. The SCS link transmission allows data exchanges between FCS and SCS.

SEE ALSO
For more information about SCS link transmission, refer to:
- 2.9, “SCS Link Transmission” in Engineering Guide (IM 32Q01C10-31E)
- A6., “SCS link transmission” in Safety Control Station Reference (IM 32Q03B10-31E)

For more information about external communication function blocks, refer to:
- C9., “External communication function blocks” in Safety Control Station Reference (IM 32Q03B10-31E)

For more information about the details of data setting from FCS, refer to:
- D5., “Data setting using external communication function blocks” in Safety Control Station Reference (IM 32Q03B10-31E)

SCS link transmission

To exchange data between SCS and FCS, APCS, or GSGW, communications data must be assigned to the SCS link transmission function block. You can define the assignment using SCS Link Transmission Builder.

The engineering flow for enabling data exchanges using the SCS Link Transmission is as follows:

SEE ALSO
For more information about using SCS Link Transmission Builder, refer to:
- 5.3, “SCS Link Transmission Definition” in Engineering Reference (IM 32Q04B10-31E)

- **Engineering flow for sending data from SCS to FCS**
  1. Open the SCS Link Transmission Builder, select SCS Link Transmission Definition, and set Send to [Yes] on the Self Station tab.
  2. Open the Dictionary View in the SCS Manager, define the LTSND (link transmission data output) function block.
  3. In the SCS Link Transmission Builder, select the Data Wiring Definition and then the Self Station number. Define the LTSND function block for the bit number (bitNo).
  4. Open the Multi-Language Editor and place the LTSND function block in the application logic.

- **Engineering flow for receiving data from FCS**
  1. Select SCS Link Transmission Definition in the SCS Link Transmission Builder. Configure the settings as follows in the Self Station tab:
     - In the tab, set [Receive] to [Yes].
     - In the Other Stations tab, select the station number of FCS and set [Type] to [2: FCS].
  2. Open the Dictionary View in the SCS Manager, define the LTFCS (Interference-free link transmission data input) function block.
  3. In the SCS Link Transmission Builder, select the Data Wiring Definition and then the FCS station number. Define the LTFCS function block for the bit number (bitNo).
4. Open the Multi-Language Editor and place the LTFCS function block in the application logic.

### External communication function blocks

#### Engineering flow

The engineering procedure for setting data using an external communication function block is as follows:

1. Define an external communication function block instance using Dictionary View of SCS Manager.
2. Use Multi-Language Editor to insert the external communication function block instance defined in step 1 into the application logic.
3. Use Tag Name Builder to define a tag name for the instance defined in 1.

---

**IMPORTANT**

Do not set data periodically to SCSs from PID, MLD and other regulatory control blocks or CALCUL and other arithmetic/logic calculation blocks using the inter-station data link blocks (ADLs) of FCSs. Doing so can result in a writing error.

---

**SEE ALSO**

For more information about data setting through a tag name interface, refer to:

“Limitations on the Number of Data Setting Requests via Tag Name Interfaces” in 2.16, “CENTUM Integration” in Engineering Guide (IM 32Q01C10-31E)
2.1.7 Accessing subsystem's data from CENTUM

CENTUM can access the subsystem data after the names of the communication input function blocks and the communication output function blocks are defined. Moreover, CENTUM can set data to the subsystem through the external communication function blocks (ECW_*).

Reading subsystem's data by CENTUM

CENTUM can read data in the subsystem through a tag name interface.

You need to assign tag names to the instances of the function blocks for subsystem communication in advance.

The communication data read by CENTUM are logical data.

Setting subsystem's data by CENTUM

Through the external communication function block (ECW_*), CENTUM can set data in the subsystem through a tag name interface. The logic between the external communication function blocks and the subsystem communication output function blocks needs to be created.

**IMPORTANT**

Do not frequently set data from CENTUM to the subsystem through the external communication function blocks using tag name interfaces. Doing so can result in a writing error.
See also

For more information about setting data using tag name interfaces, refer to:

- "Limitations on the Number of Data Setting Requests via Tag Name Interfaces" in 2.16, "CENTUM Integration" in Engineering Guide (IM 32Q01C10-31E)

For more information about external communication function blocks, refer to:

C9., "External communication function blocks" in Safety Control Station Reference (IM 32Q03B10-31E)
2.1.8 Plant hierarchy

The Plant hierarchy shows the equipment and devices on a control system in a hierarchical structure conforming to the physical model specified in the ISA S88.01. Function blocks named from the Tag Name Builder on the ProSafe-RS can be registered as equipment objects in the Plant hierarchy on the Control system. HIS is capable of filtering process alarms based on the plant hierarchy and of displaying process alarms for any equipment object.

**SEE ALSO**

For more information about the Plant Hierarchy, refer to:

- "Plant hierarchy“ in D1., "Integration with CENTUM“ in Safety Control Station Reference (IM 32Q03B10-31E)
- 3, "Plant Hierarchy“ in the Human Interface Stations Reference Vol. 2 (IM 33K03F22-50E)
- E7, "Plant Hierarchy“ in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- E10, "Plant Hierarchy“ in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)

---

### Plant hierarchy engineering

1. Setting upper equipment names for SCS station
   
   When a new SCS is defined from the System View on the CENTUM ENG, the equipment object of SCS is automatically registered in the Plant hierarchy.
   
   Open the SCS Properties from the System View on the CENTUM ENG to specify the name of the upper equipment name than SCS.

2. Setting upper equipment name for SCS tag name
   
   The upper equipment name for each Mapping Block/Element on SCS can be specified from the Tag Name Builder. The specifiable upper equipment names are limited to those (Custom equipment name) defined from the Plant Hierarchy Builder on the CENTUM. You cannot specify the default equipment name.

3. Defining upper equipment
   
   Use the Plant Hierarchy Builder on the CENTUM ENG.

   ![Diagram of Plant Hierarchy](image.png)

   **Figure 2.1.8-1 Example of SCS plant hierarchy**
For more information about the Plant hierarchy engineering, refer to:

- 3.2, "Plant Hierarchy Engineering" in the Human Interface Stations Reference Vol. 2 (IM 33K03F22-50E)
- E7.2, "Plant Hierarchy Engineering" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- E10.2, "Plant Hierarchy Engineering" in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)
2.1.9 Saving and downloading operation marks

The operation marks set for the mapping blocks or mapping elements of an SCS can be saved in an SENG. The saved operation marks can be downloaded to an SCS.

Save operation marks

The operation marks for the tagged elements and annunciators can be saved. The operation marks can be saved by SCS Manager at any time. The dialog box that prompts for saving the operation marks will be displayed before Offline Download, Master Database Offline Download and SCS Restart. On the dialog box, choose Yes, then the operation marks will be saved.

Procedure of saving operation marks

1. On SCS Manager, choose [Tools] > [Controller] >[Save Operation Marks]. A dialog box appears, asking you whether you want to save the operation marks.
2. Click [Yes], then saving will start with a progress bar.

Download operation marks

- The saved operation marks of the tagged data and annunciators can be downloaded.
- Only the saved operation marks of the tag names that are consistent with the tag names in the SCS can be downloaded. If the tag names are modified after saving the operation marks, the operation marks of the inconsistent tag names will not be downloaded.

IMPORTANT

- The operation marks in the SCS are initialized when you perform an Offline Download, Master Database Offline Download, or SCS manual restart, or when the SCS automatically restarts after power failure. When performing the above operations (except SCS automatic restart after power failure), a dialog box will be displayed, prompting you to save the operation marks.
- For Offline Download or Master Database Offline Download, set a security password first and then download the operation marks after the SCS shifts to Waiting mode.
- For SCS Restart, download the operation marks after the SCS shifts to Waiting mode.

Procedure of download operation marks

1. On SCS Manager, choose [Tools] > [Controller] > [Download Operation Marks] to start. A dialog box appears, asking you whether you want to download the operation marks.
2. Click [Yes], then download will start with a progress bar.
2.2 Engineering on the CENTUM side

This section describes engineering tasks performed on the CENTUM side, one of the tasks required to connect an SCS project and a CENTUM project.
2.2.1 SCS creation

To connect each SCS project to a CENTUM project, a corresponding SCS must be created in CENTUM System View first.

Creating an SCS

Create SCSs on CENTUM System View. The procedure is explained in the following section: Select [File] > [Create New] > [SCS (E)] in System View. The New Station dialog box appears.

![Create SCS dialog box](image)

Figure 2.2.1-1 Example display of the Create SCS dialog box (Type tab)

TIP
Do not select "SCS01 Safety Control Station" as the station type.

The following section describes the items defined in each tab sheet:

Definition items in the Type tab

The following describes the items defined in Type tab. The station type and station address are mandatory.

- **Station Type**
  Select the station type from the following choices:

<table>
<thead>
<tr>
<th>Station Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>[SSC60D-S Duplexed Safety Control Unit (for Vnet/IP, Rack Mountable Type, Standard Type)]</td>
</tr>
<tr>
<td>[SSC60D-F Duplexed Safety Control Unit (for Vnet/IP, Rack Mountable Type, Wide Range Temperature Type)]</td>
</tr>
<tr>
<td>[SSC60S-S Safety Control Unit (for Vnet/IP, Rack Mountable Type, Standard Type)]</td>
</tr>
<tr>
<td>[SSC60S-F Safety Control Unit (for Vnet/IP, Rack Mountable Type, Wide Range Temperature Type)]</td>
</tr>
<tr>
<td>[SSC50D-S Duplexed Safety Control Unit (for Vnet/IP, Rack Mountable Type, Standard Type)]</td>
</tr>
</tbody>
</table>

Continues on the next page
### Station type list (Table continued)

<table>
<thead>
<tr>
<th>Station Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>[SSC50D-F Duplexed Safety Control Unit (for Vnet/IP, Rack Mountable Type, Wide Range Temperature Type)]</td>
</tr>
<tr>
<td>[SSC50S-S Safety Control Unit (for Vnet/IP, Rack Mountable Type, Standard Type)]</td>
</tr>
<tr>
<td>[SSC50S-F Safety Control Unit (for Vnet/IP, Rack Mountable Type, Wide Range Temperature Type)]</td>
</tr>
<tr>
<td>[SSC10D-S Duplexed Safety Control Unit (for Vnet, Rack Mountable Type, Standard Type)]</td>
</tr>
<tr>
<td>[SSC10D-F Duplexed Safety Control Unit (for Vnet, Rack Mountable Type, Wide Range Temperature Type)]</td>
</tr>
<tr>
<td>[SSC10S-S Safety Control Unit (for Vnet, Rack Mountable Type, Standard Type)]</td>
</tr>
<tr>
<td>[SSC10S-F Safety Control Unit (for Vnet, Rack Mountable Type, Wide Range Temperature Type)]</td>
</tr>
</tbody>
</table>

#### Station Address

Set the station address. A station address consists of a domain number and a station number. Although any domain number from 1 to 31 can be set for a ProSafe-RS station, set only a value between 1 and 16 when the station is used in the CENTUM integration structure. The default domain number is the number set in the project. The station number should be set from 1 to 64. The default station number is the next available blank number found in a search in ascending order from 1. Once a station address is set, it cannot be changed. The only way to change the station address is to delete the existing station and then create a new one with new address.

#### Component Number

You can set a component number between 0 and 9999. The setting of component number may be omitted.

#### Station Comment

You can set a comment for the station. The setting of station comment may be omitted. Set the comment using up to 24 single-byte or 12 double-byte characters.

#### Alias of Station

You can set an alias for the station. When an alias is set, all names of the station displayed on an HIS will be replaced by the alias. Set the alias using up to eight single-byte alphanumeric characters.

#### Station Status Display

Set the name of the window you want to display on an HIS in place of the Station Status Display view. The name of the Station Status Display view is set using up to 16 single-byte alphanumeric characters. Double-click the SCS icon in the System Status Overview view to display the window set here.

#### Upper Equipment Name

Specify the name of the equipment located in a level above the station. The upper equipment name should use the corresponding equipment name set in Plant Hierarchy Builder.

When a new SCS is defined, an SCS equipment object is registered in the plant hierarchy automatically. Different equipment can be specified for each Mapping Blocks/Elements of the SCS.
For more information about plant hierarchy builder, refer to:

- 3.2.2, "Registering Custom Equipment (Other than Unit Equipment)" in the Human Interface Stations Reference Vol. 2 (IM 33K03F22-50E)
- E7.2.2, "Registering Custom Equipment (Other than Unit Equipment)" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- E10.2.2, "Registering Custom Equipment (Other than Unit Equipment)" in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)

### Downloading the project common

In the CENTUM integration structure, the project common is used to build a system for operating and monitoring SCSs from HISs. So, download the project common.

In the engineering of HISs and FCSs in a CENTUM project, the common items in the project are defined as the project common (COMMON). The definitions in the project common are shared by all HISs and FCSs in the same CENTUM project. Accordingly, modifying the project common will also modify the corresponding HIS/FCS definitions.

**TIP** Changing the project common of a CENTUM project will not affect SCS applications. Therefore, reengineering is not required on an SENG after the project common has been changed.
2.2.2 SCS taglist generation

To access mapping blocks/elements on an SCS from an HIS using the corresponding tag names defined in ProSafe-RS Tag Name Builder, a taglist for the SCS must be generated on the CENTUM side. CENTUM taglists are generated using the Taglist Generation Function included in the CENTUM Engineering Function.

Generating SCS taglist on CENTUM

Launch Taglist Generation Function from System View.

1. In System View, select the SCS you want to generate a taglist for.
2. Select [Tools] > [SCS Taglist Import] from the menu.
   An HIS taglist is generated.

Taglist Generation Function generates an HIS taglist based on the corresponding SCS taglist file generated in the Engineering Function of the ProSafe-RS. If the CENTUM project is the current project, the taglist is downloaded to the HIS. The result of Taglist Builder operation appears in the message area of System View.

Engineering unit symbol and switch position label

Keep the engineering unit symbol and switch position label modes to AUTO while generating a SCS taglist.

When an SCS taglist is generated in the MANUAL model, if engineering unit symbols and switch position labels not present in the CENTUM project are included in the engineering information (taglist, etc.) of the SCS, they will not be registered in the CENTUM project, and a warning message appears as a result. In this case, register the engineering unit symbols and switch position labels that generated the warning message in the respective builders, and then generate a taglist again.

SEE ALSO

For more information about mode of the engineering unit symbol and switch position label, refer to:

- 2.2, "Creating a New Project" in the CENTUM VP Engineering Reference Vol. 1 (IM 33K03G21-50E)
- F2.2, "Creating a New Project" in the CENTUM VP Reference Engineering (IM 33M01A30-40E)
- F1.2, "Creating a New Project" in the CS 1000/CS 3000 Reference Engineering (IM 33S01B30-01E)

Downloading a taglist

Each generated taglist can be downloaded to an HIS that requires it. Taglists can be downloaded using the TagList Down Load dialog box called from System View.

Taglist download operation

   The TagList Down Load dialog box appears.
2. Select the desired project, and then click the [View] button. A list of stations appears.

3. Select the SCS, and the HIS you want to download the taglist to, and then click the [Equalize] button. The generated taglist is downloaded to the selected HIS.

- **Cautions after downloading database**

  In the CENTUM integration structure, if a database is downloaded (offline or online-change) from the SENG to SCS, be sure to generate a SCS Tag List from the System View on the CENTUM ENG. Otherwise, databases on HIS or Exaopc conflict, and trigger a system alarm message prompting you to equalize the database in the startup process of HIS or Exaopc.
2.2.3 Other builders

To connect an SCS project with a CENTUM project, the following builders and viewer are required:

- Operation Mark Builder
- Plant Hierarchy Builder
- Plant Hierarchy Viewer
- FCS Constants Builder

### Operation Mark Builder

Setting operation marks using Operation Mark Builder of the CENTUM ENG allows the assignment of tag with comment in the instrument faceplate or the change of operation privileges over mapping blocks/elements.

The definitions set in Operation Mark Builder are used commonly by all FCSs, HISs and SCSs in the CENTUM project.

If an operation mark is added or modified in Operation Mark Builder, the action of the operation mark on HISs will change once the addition/modification is downloaded to the HISs.

**IMPORTANT**

- The initial value of operation marks for mapping blocks/elements is 0 (no operation mark). When the SCS is restarted, the setting of operation marks will return to the initial value.
- An offline download (or master database offline download) to the SCS will cause the setting of operation marks to return to the initial value.
- Values cannot be specified for operation marks for mapping blocks/elements using the ProSafe-RS Engineering Function.
- Operation mark values cannot be changed using the SCS application logic.

**SEE ALSO**

For more information about operation marks, refer to:

- 3.5, "Operation Mark" in the CENTUM VP Engineering Reference Vol. 1 (IM 33K03G21-50E)
- F3.5, "Operation Mark" in the CENTUM VP Reference Engineering (IM 33M01A30-40E)
- F9.5, "Operation Mark" in the CS 1000/CS 3000 Reference Engineering (IM 33S01B30-01E)

For more information about how to restore operation marks, refer to:

2.1.9, “Saving and downloading operation marks” on page 2-32

### Plant Hierarchy Builder

Use the Plant Hierarchy Builder for registering Custom equipment. To activate the Plant Hierarchy Builder, in the System Engineering function, bring up the System View. In the List view, double click [Common] > [Custom Plant].

**Plant Hierarchy Viewer**

In the Plant Hierarchy Viewer, you can confirm the Custom equipment name registered from the Plant Hierarchy Builder. The Plant Hierarchy Viewer shows the plant hierarchy of the entire projects.

From the menu on the System View window on the CENTUM ENG, select [Tool] > [Plant Hierarchy Viewer]. SCS tags are shown in the Plant Hierarchy Viewer window.

**TIP**

The versions of CS 3000 below R3.08 are not capable of showing SCS tags in the Plant Hierarchy Viewer.
**FCS Constants Builder**

If SCS exchanges data with FCS using the SCS link transmission, set present station definition and station definition of scan transmission definition.

The SCS data that can be referenced at FCS are %GS001 to %GS128.

---

For more information about scan transmission definition settings in the FCS Constants Builder, refer to:

- "Scan Transmission Definitions" in A4.2, "Global Switch" in the Field Control Stations Reference (IM 33K03E10-50E)
- "Scan Transmission Definitions" in A4.2, "Global Switch" in the CENTUM VP Reference Field Control Station Basics (IM 33M01A30-40E)
- "Scan Transmission Definitions" in A4.2, "Global Switch" in the CS 1000/CS 3000 Reference Field Control Station Basics (IM 33S01B30-01E)
2.2.4 Items to note on CENTUM engineering

This section describes the items to be noted in CENTUM engineering.

■ Software I/Os supported on SCS

Among the various software I/Os of CENTUM FCS, common switches and annunciators can be used on SCS.

- Common switches

The SCS common switches having an element number between %SW0001 and %SW0400 are system common switches. The system common switches are elements having a predefined purpose, such as identification of SCS status. All common switches of SCSs are system common switches.

Tag names cannot be defined for SCS common switches. Also, values cannot be set in common switches.

SEE ALSO
For more information about the content of each SCS common switch element number, refer to:

- “Software inputs/outputs” in D1., “Integration with CENTUM” in Safety Control Station Reference (IM 32Q03B10-31E)

- Annunciators

Annunciators are used as mapping elements for ANN and ANN_FUP function blocks. Each message can be defined using up to 80 single-byte or 40 double-byte characters.

■ Data setting from FCS to SCS

Using SFC (Sequential Function Chart) can set data from FCS to SCS.

All the SCS data are accessible by assigning the tag names to the mapping elements on the Tag Name Builder of SENG. And the SCS data can be written from FCS by assigning the data to the external communication function blocks.

SEE ALSO
For more information about the details of data setting from FCS, refer to:

- D5.1, “Confirmation of setting data” in Safety Control Station Reference (IM 32Q03B10-31E)
- 2.1.6, “Settings for exchanging data between FCS and SCS” on page 2-26
2.3 Tests in the CENTUM integration structure

The following two types of tests can be performed between SCS and FCS/HIS in the CENTUM integration structure.

- Target test using the target SCS
- SCS simulation test with the CENTUM virtual test combined

**Target tests in the CENTUM integration structure**

The target tests in the CENTUM integration structure are conducted with a CENTUM target test environment combined.

**IMPORTANT**

If you use the application debug function in the target tests, set the SCS security level to "Level 0."

To return to the online level after the target tests, an offline download has to be executed.

For more information about target test, refer to:

4., "Target tests" in ProSafe-RS System Test Reference (IM 32Q04B30-31E)

**SCS simulation tests in the CENTUM integration structure**

In the SCS simulation tests in the CENTUM VP integration structure, you can test using an SCS simulator instead of an actual SCS.
For more information about SCS simulation test, refer to:

3.6, “Testing CENTUM integration in virtual tests” in ProSafe-RS System Test Reference (IM 32Q04B30-31E)
3. Overview of Safety System Operation and Monitoring Using HIS

In the CENTUM integration structure, HIS can operate and monitor SCS data through tag names in the same interface as that of FCS data. Because SCS application logic is created with IEC 61131-3 language, it is necessary to define mapping blocks/elements in the SCS and assign tag names with Tag Name Builder to realize the tag name interface. In addition, it is possible to monitor the SCS status and alarms by HIS standard windows.

**Overview of Safety System Operation and Monitoring Using HIS**

The following outlines the operation and monitoring of an SCS by an HIS in the CENTUM integration structure.

- Operate and monitor SCS data using tag names via the same interface used for operating and monitoring FCS data. Data can be referenced using the instrument faceplate, and SCS data can be displayed in the Graphic view.
- Monitor in HIS's Process Alarm view both occurrence and recover of process alarms and annunciators detected by SCSs.
- Monitor in HIS's System Alarm view all system alarms occurred on SCS.
- Display in HIS's SCS Station Status Display view the operating status of SCS.

**Windows used for operation and monitoring of SCS**

The following windows are mainly used for operation and monitoring of SCSs from an HIS:

<table>
<thead>
<tr>
<th>Window name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Alarm view</td>
<td>Check system alarms generated on SCSs</td>
</tr>
<tr>
<td>Process Alarm view</td>
<td>Check process alarms and annunciator messages generated on SCSs</td>
</tr>
<tr>
<td>SCS Station Status Display view</td>
<td>Monitor the operating status of SCSs</td>
</tr>
<tr>
<td>Instrument faceplate</td>
<td>Operate and monitor SCSs using the instrument faceplates of mapping blocks/elements</td>
</tr>
<tr>
<td>Graphic view</td>
<td>Monitor the data of mapping blocks/elements</td>
</tr>
</tbody>
</table>

The following functions can be implemented from an HIS using the above windows:

- Learn SCS alarms in real time
- Check the status of each SCS controller
- Perform maintenance override of SCSs from an HIS

**Notes on online change**

While operating a grouping override function block, override function block, or password function block from an HIS, do not perform online change download.
Even if the target of operation from the HIS is a function block or mapping block not subject to online change, the override operation itself may generate an error. In this case however, the online change communication will not be affected. Wait for the communication for online change to end, and then operate the grouping override function block, override function block or password function block again.

- **Error notification method**

  If an operation from HIS generates an error while online change download is running, you are notified in the following ways:
  
  - Notification by a system alarm
  - Notification by an answerback error alarm from the tag name of the applicable mapping block (based on notification enabling specification in Tag Name Builder)

  **SEE ALSO**

  For more information about the definition of the answerback error in Tag Name Builder, refer to:

  “Setting items” on page 2-11
3.1 Windows used for operation and monitoring of SCS

This section describes the primary windows used in the operation and monitoring of SCSs from an HIS.
### System Alarm view

The System Alarm view displays a list of diagnostic information messages that notify hardware and communication errors in the system as system alarm messages. The system alarm messages are predefined in the system.

**Overview of the System Alarm view**

The System Alarm view displays and manages the system alarm information notified by SCSs and FCSs as system alarm messages. Both SCS and FCS system alarm messages can be displayed in the same window.

When an SCS detects an error by its diagnostic functions, the SCS issues a system alarm message. When the error is recovered, a recovery message is issued. Each SCS also issues a system alarm as a confirmation of an operation performed to the SCS, such as security level change or forcing of variables. The System Alarm view displays these messages as system alarms. The following is an overview of the System Alarm view:

- When an alarm has occurred in SCS, the [SCS Alarm occurrence Notification] button on the toolbar changes to notify the occurrence of an SCS alarm. When the button is clicked, the message is displayed after being filtered by the Safety Control Station filter.
- Once the operator acknowledges the system alarm, the system alarm message will stop flashing.
- When the system alarm is cleared, the corresponding system alarm message is deleted from the window.
- The corresponding alarm class information managed by the SCS is displayed together with each system alarm.
- System alarm messages generated on SCSs can be filtered into a separate group for display. This function allows for easy distinction of SCS alarms from FCS alarms even when a large number of system alarm messages have been generated on FCSs.
- If SCS alarms are present, calling the System Alarm view will automatically filter the alarm messages by the Safety Control Station filter before the window is displayed.

### Selection of display items

Call the Window Setting dialog box from the applicable tool button in the System Alarm view. When this dialog box is first opened, the Display Item name check box is unchecked. Checking this box will enable the selection of items you want to display in the System Alarm view.
The following table shows the default display items in the System Alarm view and items that can be displayed or hidden.

**Table 3.1.1-1 Display items in the System Alarm view**

<table>
<thead>
<tr>
<th>Display item name</th>
<th>Default window setting</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Displayed</td>
<td>Yes</td>
</tr>
<tr>
<td>MsgNo</td>
<td>Displayed</td>
<td>Yes</td>
</tr>
<tr>
<td>Date</td>
<td>Displayed</td>
<td>No</td>
</tr>
<tr>
<td>Level(*1)</td>
<td>Not displayed</td>
<td>Yes</td>
</tr>
<tr>
<td>Message</td>
<td>Displayed</td>
<td>No</td>
</tr>
</tbody>
</table>

*1: The displayed level corresponds to the SCS alarm class (1 to 4).

### Split display

The System Alarm view can be displayed into two frames.

When a filter is set, the view is split horizontally, with the messages matching the filter condition displayed in the top frame and all messages displayed in the bottom frame.
For more information about the split display of the System Alarm view, refer to:

- "Splitting System Alarm View" in 4.2.3, "Filter and Display System Alarm Messages" in the Human Interface Stations Reference Vol. 1 (IM 33K03F21-50E)
- "Splitting System Alarm View" in E4.2.3, "Filter and Display System Alarm Messages" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- "Splitting System Alarm Window" in E7.2.3, "System Alarm Message Search and Display" in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)

### Specification of system alarm filters

The following filters can be specified in the System Alarm view:

- **All**
  All system alarm messages are displayed.

- **Station Name**
  System alarm messages generated in the selected station are displayed.

- **Current Station**
  Alarm messages generated in the current station are displayed.

- **Safety Control Station**
  System alarm messages generated on SCS are displayed.

  All ProSafe-RS SCSs become the target of filtering.

![Figure 3.1.1-3 System alarm filter setting dialog box](image-url)
3.1.2 Process Alarm view

The Process Alarm view displays process alarms including annunciator messages.

For more information about the Process Alarm view, refer to:
- 3.6, "Process Alarm View" in the Human Interface Stations Reference Vol. 1 (IM 33K03F21-50E)
- E3.6, "Process Alarm View" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- E4.6, "Process Alarm Window" in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)

Overview of the Process Alarm view

The Process Alarm view displays and manages the process alarm information notified by SCSs and FCSs as process alarm messages and annunciator messages.

- When a process alarm has occurred in SCS, the [SCS Alarm occurrence Notification] button display on the toolbar changes to notify the occurrence of an SCS alarm. When the [SCS Alarm Occurrence Notification] button is clicked, the message is displayed after being filtered by the [Safety Control Station] filter.
- SCS process alarms can be acknowledged and deleted in the Process Alarm view. Acknowledging or deleting an SCS process alarm on an HIS will change the corresponding process alarm information managed on the SCS.
- Process alarm messages occurred in SCSs can be filtered into a separate group for display. This function allows for easy distinction of SCS alarms from FCS alarms even when a large number of process alarm messages have been generated on FCSs.
- If SCS alarms are present, calling the Process Alarm view will automatically filter the alarm messages using the [Safety Control Station] filter before the window is displayed.

Selection of display items

Call the Window Setting dialog box from the applicable tool button in the Process Alarm view. When this dialog box is first opened, the Display Item name check box is unchecked. Checking this box will enable the selection of items you want to display in the Process Alarm view.

![Window Setup](image)

Figure 3.1.2-1 Window Setup dialog box

The following table shows the default display items in the Process Alarm view and items that can be displayed or hidden.

<table>
<thead>
<tr>
<th>Display item name</th>
<th>Default window setting</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Displayed</td>
<td>Yes</td>
</tr>
<tr>
<td>Date</td>
<td>Displayed</td>
<td>No</td>
</tr>
<tr>
<td>Level(*1)</td>
<td>Not displayed</td>
<td>Yes</td>
</tr>
<tr>
<td>Message</td>
<td>Displayed</td>
<td>No</td>
</tr>
</tbody>
</table>
*1: The displayed level corresponds to the alarm priority level.

### Split display

The Process Alarm view can be displayed into two frames.

When a filter is set, the view is split horizontally, with the messages matching the filter condition displayed in the top frame and all messages displayed in the bottom frame. However, if an alarm priority filter is selected in the Alarm tab on the HIS Setup window, both the top and bottom frames display only the messages of the specified priorities.

**Figure 3.1.2-2 Split display of the Process Alarm view**

Search and display of process alarm messages

Process alarm messages and annunciator messages can be searched for using the following keywords:

- **Search range specification**
  - **All**
    
    All process alarm messages and annunciator messages are displayed.
  - **FCS Name**
    
    Process alarm messages and annunciator messages generated in the selected control station are displayed.
  - **Plant Hierarchy Name**
    
    Process alarm messages and annunciator messages generated in the selected control drawing name or unit instrument tag name are displayed.
- Tag Name
  Process alarm messages and annunciator messages relating to the specified function block are displayed.

- Batch ID
  Process alarm messages and annunciator messages relating to the specified batch ID are displayed.

- Safety Control Station
  Process alarm messages and annunciator messages generated on SCSs are displayed. All ProSafe-RS SCSs become the target of filtering.

- **Search types**
  - All
    Process alarm messages and annunciator messages are displayed.
  - Function Block Only
    Only process alarm messages are displayed.
  - Annunciator Only
    Only annunciator messages are displayed.

![Alarm filter setting dialog box](image)

*Figure 3.1.2-3 Alarm filter setting dialog box*
3.1.3 Instrument faceplates

Instrument faceplates display statuses and data of function blocks, mapping blocks, and elements assigned on the Tag Name Builder. Instrument faceplates of SCS and FCS are distinguished by the color of the mark in the bottom of the faceplate.

**IMPORTANT**
The operator must utilize the SCS instrument faceplate mainly for monitoring.
Follow the predefined procedure to operate an SCS instrument faceplate.

### Instrument faceplate display

Mapping blocks can be called from an HIS as the instrument faceplate.
The function block types are displayed as follows (the corresponding mapping block types are shown after the colon ":`").

- **IO_BOOL** : %Z
- **ANN, ANN_FUP** : %AN
- **ANLG_S** : S_ANLG_S
- **ANLGI** : S_ANLGI
- **VEL** : S_VEL
- **PASSWD** : S_PASSWD

![Image of instrument faceplate display (existing instrument)](image)

Figure 3.1.3-1 Image of instrument faceplate display (existing instrument)
Figure 3.1.3-2 Image of instrument faceplate display (existing instrument)

For more information about instrument faceplate, refer to:
• 2., "Instrument Faceplate" in the Human Interface Stations Reference Vol. 2 (IM 33K03F22-50E)
• E6., "Instrument Faceplate" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
• E8., "Instrument Faceplate" in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)

- **Operation of password function blocks and manual operation blocks**
  - **PASSWD, MOB_21, MOB_11, MOA**
    If you set values of MV, enter the password in the password dialog box.
    If you enter the wrong password, MV values are reset to the previous values before the change.
  - **MOA**
    To close the INC/DEC dialog box, click anywhere outside the dialog box. If no action is made, the dialog box closes in about 30 seconds.

- **Instrument faceplate**
  On the instrument faceplates of SCS and FCS, the mark in the bottom is displayed in different colors.
Table 3.1.3-1 Color of the mark in the bottom of faceplates

<table>
<thead>
<tr>
<th>Station</th>
<th>mark color</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CENTUM VP HIS</td>
</tr>
<tr>
<td>FCS</td>
<td>Dark Blue</td>
</tr>
<tr>
<td>SCS</td>
<td>Orange</td>
</tr>
</tbody>
</table>

**TIP**

Related builders cannot be called using a tag name.

**Operation marks**

The settings for operation mark provide the function to notify the operator of various statuses of equipment, such as under maintenance, out of order or operation prohibited. When an operation mark is set, a tag with comment is set in the instrument faceplate. By assigning an operation mark, the operation privileges over the instrument faceplate can be changed temporarily.

**SEE ALSO**

For more information about the settings for the operation marks, refer to:

- "Toolbar of Tuning View" in 3.3.1, "Components of Tuning View" in the Human Interface Stations Reference Vol. 1 (IM 33K03F21-50E)
- "Toolbar of Tuning View" in E3.3.1, "Components of Tuning View" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- "Toolbar of Tuning Window" in E4.3.1, "Components of Tuning Window" in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)

**Two-step operation setting for switch faceplates**

Operation of the instrument faceplate buttons in the following function blocks is always in two steps, regardless of the settings in the instrument faceplate operation definition tab in the HIS constants builder.

- Grouping Override Function Block (GOV_* )
- Override Function Block (OVR_* )
- Password Function Block (PASSWD)
- Data Manual Operation with Answerback Function Block (MOB_* )
- Auto-reset Data Manual Operation Function Block (MOB_RS)

**SEE ALSO**

For more information about the two-step operation, refer to:

- "Two-Step Operation" in 2.5, "Operation Type on Instrument Faceplate" in the Human Interface Stations Reference Vol. 2 (IM 33K03F22-50E)
- "Two-Step Operation" in E6.5, "Operation Type on Instrument Faceplate" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- "Two-Step Operation" in E8.5, "Operation Type on Instrument Faceplate" in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)

**Reconfirmation dialog box**

For the following function blocks, if you try to operate the MV using the instrument faceplate and data input dialog box, the reconfirmation dialog box always appears, regardless of the tag mark setting. You cannot disable the reconfirmation dialog box by the tag mark setting.

- Grouping Override Function Block (GOV_* )
- Override Function Block (OVR_* )
• Password Function Block (PASSWD)
• Data Manual Operation with Answerback Function Block (MOB_*)
• Auto-reset Data Manual Operation Function Block (MOB_RS)
• Analog-type Data Manual Operation Function Block (MOA)
3.1.4 SCS Station Status Display view

The SCS Station Status Display view displays the operating status of each SCS, such as scan period and security level.

**IMPORTANT**

SCSs cannot be started or stopped from the SCS Station Status Display view, regardless of the roles assigned to the operator on the HIS.

### System Status Overview view

The System Status Overview view displays the status of the system over the control bus, including SCS, HIS and FCS. SCS icons are the same as FCS icons, except SCS icons are shown in orange in HIS for CENTUM VP, and in green in HIS for CS 3000.

When V net is used, “V net1” and “V net2” are displayed instead of “Vnet/IP1” and “Vnet/IP2,” respectively.

![System Status Overview view](image)

**Figure 3.1.4-1 System Status Overview view**

![SCS icon](image)

(a) Normal  (b) Faulty  (c) Left CPU is faulty

**Figure 3.1.4-2 SCS icons**

### SCS Station Status Display view

The SCS Station Status Display view displays the status of an SCS in detail. Operating mode, scan period and security level are shown in this window. In this window, whether or not the
The HIS's SCS Station Status Display view displays the information that has been read from each SCS. However, the Diagnostic Information Operating dialog box in SCS Maintenance Tool cannot be opened from this window.

---

**Figure 3.1.4-3 SCS Station Status Display view**

- **Toolbar of the SCS Station Status Display view**

  The following operations can be performed from the toolbar in the SCS Status Display view:

  - CPU Idle Time
  - Comm Load
  - Control status
  - Scan period
  - Set scan period
  - Program run time
  - Operating Mode
  - Security level
  - Number of points under forcing
  - Number of stations locked in SCS link transmission
  - Number of stations locked in Inter-SCS safety communication
  - Communication I/O lock status
  - Time Sync
  - Temperature
  - Intake temperature
  - Exhaust temperature
  - Battery temperature
  - Fan
  - SCU fan
  - Battery status

---

*1: When V net is used, “V net1” and “V net2” are displayed instead of “Vnet/IP1” and “Vnet/IP2,” respectively.

*2: For SCS with system program R2.02 or earlier, the set scan period is displayed.

*3: When V net is used, the “IRIG-B : Ready” is displayed instead of “Time Sync : Vnet/IP.”
Selecting this button will call the System Alarm view where alarm details can be checked. If a system alarm message is present, the button will flash in red.

Selecting this button will call the HIS Setup window.

Selecting this button will call the Adjust Time dialog box.

Selecting this button will call the System Status Overview view.

The SCS report dialog box to show the station information. The contents in the dialog box can be printed out or exported into a file.

- Station information display

The following information is displayed in the SCS information:

- Station name
- Station comment
- Station number
- Station type
- SCS system program revision
- Last generated date/time
  The date and time of the last download to the SCS is displayed for each of the following DBs:
  - POU DB (application data)
  - Variable DB (symbol table data)
  - System DB (safety system data)
  - Integration DB (CENTUM integration data)
- CPU idling time (seconds)
  The CPU idling time per minute is displayed.
- Communication load (%)
  The V net communication load against CPU load of the safety control station is displayed in percentage. The displayed values are current load and the moving average load against minute.
- Control status
  [RUN] is displayed when the SCS is running, and [STOP] is displayed when the SCS is stopped, both in cyan color.
- Scan period (milliseconds)
  This is the actual scan period of the SCS. Note that the set scan period is displayed for SCS with system program R2.02 or earlier.
- Set scan period (milliseconds)
  The set scan period for the SCS is displayed.
- Program execution time (%)
- Operating mode
[RUNNING] is displayed when the SCS in the Running mode, [WAITING] is displayed when the SCS is in the Waiting mode, and [INITIAL] is displayed when the SCS is in the Initial mode.

- Security level
- Number of points under forcing
- Number of stations locked in SCS Link Transmission
- Communication I/O lock status
  - [Yes] is displayed when the communication I/O data is locked, and [No] is displayed when the communication I/O data is not locked.
- Number of stations locked in Inter-SCS Safety Communication
- IRIG-B connection status
  - This item is displayed if IRIG-B time synchronization is specified.
- Time Synchronization Method
  - This is displayed only when the control bus is Vnet/IP. If the SCS is synchronized with SNTP server, [SNTP] is displayed; if it is not synchronized with SNTP server, [Vnet/IP] is displayed.

**SEE ALSO**
For more information about the actual and set scan period, refer to:
A3.1.2, “Automatic extension function for scan period of the application logic execution function” in Safety Control Station Reference (IM 32Q03B10-31E)

### Station status display

The following statuses are displayed in the SCS station status: The character string representing each item is displayed in green if the status is normal, or red if faulty. If the status is faulty, a mark indicating fault is displayed.

- **Battery (XL, R)**

  **Figure 3.1.4-4 The mark stands for abnormal (battery temperature abnormal)**

- Intake temperature
- Exhaust temperature
- Battery temperature
- SCU Fan
  - This item is only displayed for stations that support wide temperature ranges (SSC60S-F, SSC60D-F, SSC50S-F, SSC50D-F, SSC10S-F, SSC10D-F).
- Battery status

### Station configuration display

The following statuses are displayed in the SCS station configuration:

- **CPU Status**
  - The character string is displayed in green, red, yellow or blue when the CPU is normal, faulty, on standby or hardware ready, respectively. When a program is being copied, the character string [COPY] will flash in white. While FLASH memory is being written, [FLASH] will flash in white.
- **Power Supply Status**
  - Displayed in green if the power supply is normal, or red if faulty.
- **ESB bus status display**
  Displayed in green if the ESB bus is normal, or red if faulty. But the status of the Optical ESB Bus Repeater modules is not displayed.

- **Node configuration display**
  - Node number
  - Communication status
    The character string [COM] is displayed in green if the node is normal, or red if faulty. Note that the communication status of node 1 (CPU node) is not displayed.
  - Power supply status
    The character string [PSU] is displayed in green if the node is normal, or red if faulty.
  - Representative I/O module status
    [I/O FAIL] is displayed in red if the I/O module is faulty. Nothing is displayed if the module is normal.

**SCS Report dialog box**

The SCS Report dialog box showing the status of each SCS can be called from the SCS Station Status Display view. To call the SCS Report dialog box, use the following button on the toolbar:

The following figure shows an example of the SCS Report dialog box:

![SCS Report dialog box example](image)

**Figure 3.1.4-5 SCS Report dialog box**

- **Print**
Clicking this button prints the content currently displayed in the SCS Report dialog box. The displayed content will be output to the printer specified in the HIS Setup window.

- **File**
  Clicking this button saves the content currently displayed in the SCS Report dialog box to a FDC. The default name of the save file is "SCSRevInf.txt."

- **Close**
  Clicking this button closes the SCS Report dialog box.

## SCS Node Status Display dialog box

The SCS Node Status Display dialog box is used to display the node status of each SCS in detail. The following figure shows an example of the SCS Node Status Display dialog box:

![SCS Node Status Display dialog box](image)

**Figure 3.1.4-6 SCS Node Status Display dialog box**

### TIP
But the status of the Optical ESB Bus Repeater modules is not displayed.

- **Node status display**
  The communication status and power supply status of each node are displayed.
  - **Power Supply Status**
    The character string [PSU] is displayed in green if the node is normal, or red if faulty.
  - **24 VDC supply status**
    [DC] is displayed in red if the power supply status is abnormal.
  - **SSB401 status**
    The color of [SSB401] changes to green if the unit is normal, and red if faulty. When the SSB401 is faulty, a mark is displayed.
  - **Bus status**
    Nothing is displayed while the buses are normal. If a bus is faulty, the bus number appears in red.
  - **I/O module status**
The color of the I/O module varies with module status. Green indicates Normal. Red indicates Abnormal. Blue indicates Ready and yellow indicate Standby. The bus status is also displayed by a red-colored number.

The "-" in the I/O module name is not displayed.

- Channel status
  [CH] is displayed in red if any assigned channels are faulty.
- Serial communication status
  [nC] (n: port number) is displayed in red if communication with the subsystem fails.
3.1.5 Adjust Time dialog box

You can set or change the system date and time in the Adjust Time dialog box.

Time setting from an HIS

You can change the current network time from an HIS using the time setting function.

- Vnet/IP
  Network time on the Vnet/IP (including V net router) is synchronized with the time set on HIS. Therefore, the time on the following stations is synchronized with the time set on HIS:
  - SCS (CPU module and digital input module (SDV144))
  - SENG, FCS, HIS

If the time synchronization is based on an SNTP server, the time set on HIS is ignored.

- V net
  The network time in one V net domain and other V net domains, where Transfer/Receive System Time is specified for BCV/CGW, is synchronized with the time set on HIS. Therefore, the time on the following stations is synchronized with the time set on HIS:
  - SCS (CPU module and digital input module (SDV144))
  - SENG, FCS, HIS

However, the network time of the Vnet/IP domain is not synchronized if the domain is connected through a V net router (AVR10D) of Style S2 or earlier. SCS time with IRIG-B time synchronization is unaffected by the time change on the HIS.

SEE ALSO

For more information about the SCS time management function, refer to:

A3.2, “Time synchronization of SCS” in Safety Control Station Reference (IM 32Q03B10-31E)

For more information about the Adjust Time dialog box, refer to:

- 4.4, "Adjust Time Dialog Box" in the Human Interface Stations Reference Vol. 1 (IM 33K03F21-50E)
- E4.4, "Adjust Time Dialog Box" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- E7.11, "Adjust Time Dialog Box" in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)

For more information about setting the time for Vnet/IP and systems connected to the Vnet/IP, refer to:

### 3.1.6 Message monitor of CAMS for HIS

CAMS for HIS (Consolidated Alarm Management Software for HIS) is a software program for managing the alarms on HIS comprehensively.

This section provides information you need for monitoring a ProSafe-RS system in a HIS configured to use the CAMS for HIS.

**SEE ALSO**

For more information about CAMS for HIS, refer to:

- A1., "CAMS for HIS Overview" in the Consolidated Alarm Management Software Reference (IM 33K03H20-50E)
- E12., "Consolidated Alarm Management Software" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- M13., "Consolidated Alarm Management Software" in the CS 1000/CS 3000 Reference Options (IM 33S01B30-01E)

#### How CAMS for HIS monitors the ProSafe-RS system

If you are using CENTUM VP, you need to enable CAMS for HIS. If you are using CS 3000, you need to install the CAMS for HIS package and enable it. The System Alarm view and Process Alarm view for displaying the system alarm messages and process alarm messages from ProSafe-RS stations will be integrated by the CAMS for HIS window.

If integrated with ProSafe-RS, CAMS for HIS Message Monitor selects and displays messages of ProSafe-RS in the same manner as the System Alarm view and Process Alarm view, enabling you to view SCS messages first.

**IMPORTANT**

It is possible to filter out less important alarm messages on this window so as to make critical alarms more noticeable.

**SEE ALSO**

For more information about cautionary notes about the monitoring of ProSafe-RS using CAMS for HIS, refer to:

2.16, "CENTUM Integration" in Engineering Guide (IM 32Q01C10-31E)

- **Display example of the Message Monitor of CAMS for HIS**

  The following figure shows the Message Monitor of CAMS for HIS.
### Filtering

It is possible, with the use of filters, to configure the window to only display important alarm messages.

- The Safety Instrumented System (SIS) filter is given the highest priority by default, such that only messages from SCSs will be displayed. The details of the filter settings are displayed in the Filter pane.

- When opening the Message Monitor of CAMS for HIS, if SIS messages exist, the SIS filter will automatically take effect, such that messages from SCSs are displayed with the highest precedence.

---

For more information about the Message monitor of CAMS for HIS, refer to:

- A2., "Main Operations on Message Monitor of CAMS for HIS" in the Consolidated Alarm Management Software Reference (IM 33K03H20-50E)
- E12.3, "Overview of the Message Monitor of CAMS for HIS" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- M13.2, "Message Monitor of CAMS for HIS" in the CS 1000/CS 3000 Reference Options (IM 33S01B30-01E)
Shelving

The messages with lower priorities can be temporarily shelved (put aside as if put on a shelf) so that the A&E Message Pane can be freed for other purposes.

**IMPORTANT**

The messages from SCSs should always be handled with the highest priority. These messages should never be put on the shelves.

For more information about shelving, refer to:

- A4.2.4, "Shelving" in the Consolidated Alarm Management Software Reference (IM 33K03H20-50E)
- E12.5.1, "Shelving" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- M13.3.1, "Shelving" in the CS 1000/CS 3000 Reference Options (IM 33S01B30-01E)

Suppression

The messages with lower priorities can be suppressed, e.g. to be silenced.

**IMPORTANT**

The messages from SCSs should always be handled with the highest priority. These messages should never be suppressed.

For more information about suppression, refer to:

- A4.2.5, "Suppression" in the Consolidated Alarm Management Software Reference (IM 33K03H20-50E)
- E12.6.1, "Suppression" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- M13.3.5, "Suppression" in the CS 1000/CS 3000 Reference Options (IM 33S01B30-01E)
3.2 Other functions used for operation and monitoring of SCS

In addition to the Override function described in the preceding section, Equalizing and trend recording are another HIS functions that can be used in the operation and monitoring of SCS. This section describes the CENTUM Security Function and Alarm Inhibition.

See Also
For more information about override from HIS, refer to:
- “Override” in 7.2.1, “Utilizing Forcing and Override Function During Maintenance” in Engineering Guide (IM 32Q01C10-31E)

Equalizing

The [SCS Taglist Import] command, which is run on System View, generates a taglist database from the information defined using the ProSafe-RS’s Engineering Function and the generated taglist database is downloaded to each HIS in the system. As a result, taglist databases on the SCS and HIS are equalized.

IMPORTANT

When you have added or changed any tag definitions using the Tag Name Builder on the SENG and downloaded the changes to the SCS, there will be inconsistencies between the databases in the SCS and HIS. To equalize the database, go to the System View and run the [SCS Taglist Import] command.

See Also
For more information about how to run the [SCS Taglist Import] command on System View, refer to:
- “Generating SCS taglist on CENTUM” on page 2-37

SCS monitoring

Each HIS function communicates with SCSs based on the equalized information. SCSs are handled in the following manner on the HIS:
- SCSs are not included in the number of FCS units operated and monitored.
- SCS tags are included in the tag monitoring points.

Trend recording

SCS tag names can be assigned for trend data recording. However, since SCSs do not support high-speed (1-second) trend recording, assigning an SCS tag name to a high-speed trend recording block will not display data. Do not assign SCS tag names to high-speed trend recording blocks.

Security function of CENTUM

The CENTUM provides a security function that changes access privileges with respect to FCS data according to the account of the operator working on each HIS. This function can be utilized for SCSs in the same manner.

These access privileges can be restricted further using the Security Function of the CENTUM. For example, an HIS account permitted to write data assigned to external communication.
function blocks and an HIS account not permitted to write such data can be set up using the Security Function of the CENTUM.

- The Security Function of the CENTUM is completely independent of the security levels of SCSs. SCS security levels cannot be manipulated from HISs.
- The Security Function of the CENTUM is completely independent of the SENG’s Engineering Security Management Function.

## Alarm inhibition

This is a function to inhibit the display, printing, and beeping sounds of the process alarm messages temporarily. It is useful when many process alarm messages are generated during the startup of SCS. System alarm messages cannot be inhibited.

### How to activate/deactivate suppress alarm function

You can turn on the Alarm Inhibition function (AOF) from HIS or from FCS targeting the Mapping block/element on the SCS.

Every time the SCS is restarted, the Alarm Inhibition function (AOF) is turned off. The switch between activate and deactivate the Alarm Inhibition function is allowed only by applications on the FCS or on the HIS. Neither the applications on the SCS nor the applications on the SENG are allowed to do so.

SEE ALSO

For more information about alarm inhibition specification, refer to:

- 7.3.4, "Alarm Inhibition (AOF)" in the Human Interface Stations Reference Vol. 2 (IM 33K03F22-30E)
- E10.3.3, "Alarm Inhibition (AOF)" in the CENTUM VP Reference Human Interface Station (IM 33M01A30-40E)
- E12.3.3, "Alarm Inhibition (AOF)" in the CS 1000/CS 3000 Reference Human Interface Station (IM 33S01B30-01E)

### Alarm inhibition from HIS

You can inhibit alarm for Tag data of SCS by using AOF button on Tuning view of HIS. The Tag mark color is shown in blue while the function is on.
**Figure 3.2-1 Suppress alarms in a Tuning view**

**TIP**

The AOF button only appears when the mapping block/element corresponding to the tag name has the data item of AOFS.

- **Outputting suppressed alarm messages**

  On releasing the Alarm Inhibition, the suppressed alarm messages can be output for the process alarms that are still raised. This means that you can confirm the suppressed messages for the process alarms occurred during Alarm Inhibition. The time stamp of a suppressed message shows the time when the message is output upon the release of Alarm Inhibition. Whether to output the suppressed alarm messages can be specified on the SCS Constants Builder.

**SEE ALSO**

For more information about how to make settings required for outputting the suppressed messages, refer to: 3.1.3, “SCS Constants Builder” in Engineering Reference (IM 32Q04B10-31E)
Appendix 1. Differences in limitations and specifications among software release numbers of CENTUM

Limitations related to the added ProSafe-RS R2.03 features

The following table shows the limitations related to the added ProSafe-RS R2.03 features for each CENTUM software release number.

Table Appendix 1-1 Limitations related to the added ProSafe-RS R2.03 features

<table>
<thead>
<tr>
<th>Feature</th>
<th>CENTUM VP R4.02 or later / CS 3000 R3.09 or later(*1)</th>
<th>CS 3000 earlier than R3.09 / CENTUM VP earlier than R4.02 (*1)</th>
<th>Behavior on the CENTUM side when the feature is not supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>New SCS (SCSP2)</td>
<td>Yes</td>
<td>No</td>
<td>SCSP2 cannot be monitored or operated because the station type of SCSP2 is not available on the System View.</td>
</tr>
<tr>
<td>Support of 14 nodes (SCSP2 only)</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Expanded capacity for %AN, mapping blocks/elements, and number of tags (SCSP2 only)</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>First-up Alarm Annunciator (ANN_FUP)</td>
<td>Yes</td>
<td>No</td>
<td>Messages of ANN_FUP are not displayed.</td>
</tr>
<tr>
<td>Online change of scan period</td>
<td>Yes</td>
<td>No</td>
<td>Related system alarm messages are not displayed.</td>
</tr>
<tr>
<td>Locking of Inter-SCS Safety Communication FB</td>
<td>Yes</td>
<td>No</td>
<td>On the SCS Status Display view, the number of stations locked in Inter-SCS Safety Communication is not displayed. Related system alarm messages are not displayed.</td>
</tr>
<tr>
<td>Automatic IOM download</td>
<td>Yes</td>
<td>No</td>
<td>The same system alarm message that is displayed when IOM download is manually executed is displayed.</td>
</tr>
<tr>
<td>Automatic scan period extension during high CPU load</td>
<td>Yes</td>
<td>No</td>
<td>Related system alarm messages are not displayed. In the SCS Status Display view, only the actual scan period is displayed. The set scan period is not displayed.(*2)</td>
</tr>
<tr>
<td>Selection of SCS behavior at abnormal calculation (division by 0, overflow, access to the outside of an array)</td>
<td>Yes</td>
<td>No</td>
<td>Related system alarm messages are not displayed.</td>
</tr>
</tbody>
</table>

*1: Yes: Supported
No: Not supported

*2: To find out the set scan period, open the SCS project on the R2.03.00 or later SENG and see the Cycle Timing setting in the Settings tab of Resource Properties of the SCS Manager.

Specifications changed in CENTUM VP R5.01

- The unit "%" is not displayed for data items INV and HYS of S_ANLG_S and S_ANLGI.
The unit "%" is not displayed for data item HYS of S_VEL.
Revision Information

Title : Integration with CENTUM VP/CS 3000
Manual No. : IM 32Q01E10-31E

Jan. 2015/4th Edition/3.02.20 or later*

*: Denotes the release number of the Software Product corresponding to the contents of this Manual. The revised contents are valid until the next edition is issued.

Introduction ProSafe-RS document map has been removed, descriptions of “Safety, Protection, and Modification of the Product” have been modified.

Oct. 2013/3rd Edition/R3.02.10 or later

Introduction Description of station types has been changed.

Dec. 2012/2nd Edition/R3.02 or later

All Descriptions have been improved.

Aug. 2011/1st Edition/R3.01 or later

Newly published

For Questions and More Information

Online Query: A query form is available on the following URL for online query.
http://www.yokogawa.com/iss

Written by Yokogawa Electric Corporation
Published by Yokogawa Electric Corporation
2-9-32 Nakacho, Musashino-shi, Tokyo 180-8750, JAPAN